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Introduction

MAGic User’s Guide

About This Book

The MAGic User’s Guide teaches you to use and customize MAGic's
magnification and speech capabilities to fit your personal needs. In the
front of the book, you can find perforated keystroke reference cards that
contain a list of important MAGic commands. Chapter 7 Quick Start
Guide gives you the basics to get up and running with MAGic. Chapter 2
Navigating MAGic explains how to use your keyboard and mouse with
MAGic. Chapter 3 User Interface provides details on the buttons and
other options available on the MAGic user interface. Chapter 4
Magnification describes how to customize MAGic’'s magnification
features, including mouse, cursor, and color enhancements. Chapter 5
Speech explains how you can customize how MAGic uses synthesized
speech to read text on your screen. Chapter 6 Keyboard provides
information on customizing MAGic’s keystrokes. Chapter 7 Application
Specific Functions describes MAGic commands you can use in Microsoft
Word, Excel, and Internet Explorer. Chapter 8 Contacting Freedom
Scientific tells you how to find our Web site and contact technical
support.

Items Checklist

In your MAGic package, you should find the following items. If you
discover damaged or missing items, please contact your retailer.

e (D wallet containing one program CD-ROM and either an
authorization or update disk

o Registration disk and return mail envelope
e MAGic User’s Guide



Chapter 1
Quick Start Guide

Welcome to MAGic

MAGic is a software solution ideally suited for computer users with low
vision, or anyone who spends extended periods of time in front of a
computer screen.

MAGic lets you magnify your computer screen from 1 to 16 times its
usual size. You can choose from a number of different adjustable views
that let you see both a magnified and unmagnified portion of the screen
at the same time.

Speech features assist you in processing the information on your screen.
MAGic can read text that you type or point at with the mouse. MAGic
moves the magnified area of the screen so you always see the text
being read and highlights words as they are spoken.

Mouse and cursor enhancements help you track the location of the
mouse pointer and cursor on the screen. You can choose from a wide
variety of enhancement styles. MAGic lets you change the color of these
enhancements, apply transparency effects, adjust their size, and more.

Color enhancements let you change how colors display on your screen.
You can create rules that replace one color with another or switch two
colors. You can also apply color tinting, make your screen black-and-
white (monochrome), and invert the brightness and colors of your
display.

Other MAGic features track elements of your screen, such as the mouse
pointer, dialog boxes, and so on. The Locator feature provides you with a
way to quickly find and move to different areas of the screen. The MAGic
multi-directional panning system gives you complete control with
adjustable speed, direction, stop and start, and screen navigation
controls.



System Requirements

The recommended system requirements for MAGic are listed below.

Specification

Minimum Requirement

MAGic Standard

windows 95/98/ME/XP Home*

MAGic Professional

Windows 95/98/ME/NT/2000/XP Home
and Pro*

after installation

Processor speed 166 MHz
RAM 64 MB
Available hard disk space |75 MB
for installation

Available hard disk space |45 MB

Video

256 color graphics**

Sound

Windows compatible sound card (for
speech option)

* Some MAGic features are not available for Windows 95/98/ME users.

** While MAGic will work with 256 colors, it is recommended that you
use high or true color depth (16-bit color or higher).

Installing MAGic

1.  Insert the MAGic CD into your CD-ROM drive.

2.  When the MAGic Setup dialog box appears, choose the MAGic
Setup button. If you are installing Network MAGic, choose the
Network MAGic Setup button instead.

Tip: If your MAGic installation CD does not start automatically,
click the Start button, select Run, and type D:\setup. If your
CD-ROM is not D, substitute the correct drive letter.




3. The MAGic Setup program starts. You will hear the installation
speak the instructions as they appear on your screen. Follow these
instructions to complete the MAGic installation.

Choose to run the automatic or guided installation of MAGic. The
automatic installation assumes that you want to install all languages
and you approve of the default location where MAGic is stored on your
hard disk. Use the guided installation if you want to specify which
languages to install, where MAGic is stored on your computer, or
whether MAGic should start automatically when you start Windows.

Instructions for installing MAGic on a network can be found in the online
help system.

Uninstalling MAGic

If you want to uninstall MAGic go to the Program menu and select the
Uninstall MAGic option in the MAGic submenu.

Product Activation

After you install MAGic, you must activate your software. MAGic runs in
40 minute mode until it is activated on your computer. Internet License
Manager (ILM) allows you to quickly activate MAGic using the Internet.
If you do not have an Internet connection, you can activate MAGic by
telephone or fax. Alternatively, you can activate MAGic with the
assistance of a trusted friend, relative, or organization that has access
to the Internet.

Tip: For information on activating a multi-user network license of
MAGic, refer to the Network MAGic book in the MAGic online
help.

If you purchased a single-user license of MAGic, you are asked to
activate when you first start the program. You can activate MAGic at a
later time by opening the Help menu and choosing Update
Authorization. Choose one of the following activation methods and refer
to the listed page for detailed instructions:

e Activate using the Internet (page 5)



e Activate by Telephone (page 8)
e Activate by Fax (page 9)
e Activate with the Help of a Trusted Third Party (page 10)

Note: If you are using Windows 2000, XP, or NT, your user account
must have power user or administrator privileges to activate
MAGic. Contact your network administrator if your account
does not have the required level of access.

You can also use a dongle (a hardware device that connects to your
computer's USB or parallel port) to make your MAGic license more
portable. A dongle allows you to use an authorized version of MAGic on
any computer as long as the dongle remains connected. For more
information, see Dongle Authorization on page 12.

If your version of MAGic does not use Internet License Manager
authorization, refer to page 13 for information on 3.5-inch Disk (Quella)
Authorization.

Note: Adding or removing certain hardware components may cause
your computer's Locking Code to change. If this occurs, you
must reactivate MAGic. If you need to request more
activations, visit www.FSActivate.com.

Activating with Internet License Manager

You can use Internet License Manager (ILM) to activate MAGic using an
Internet connection. This is the easiest and quickest way to activate
your product.

When you first start MAGic, you are asked to activate the program. You
can also begin the activation process by opening the Help menu and
choosing Update Authorization. To activate MAGic using the Internet, do
the following:

1.  In the Activation dialog box, choose Start Activation.



Read the message that displays and then choose Continue. Insert
the Authorization CD into your CD-ROM drive and choose Activate
Using Authorization CD. You can find your Authorization CD in the
same sleeve as your MAGic program CD. If you do not have your
Authorization CD, choose Enter Your Authorization Number
Manually.

Note:

If you have previously inserted your Authorization CD, you
will not be asked to insert it again. Continue to step 3 of the
activation.

Choose Activate.

Use the arrow keys to select Now, Using the Internet
(RECOMMENDED), and then press ENTER.

If you used your Authorization CD, your 20-digit Authorization
number is automatically inserted into the Authorization Number
edit box. If your Authorization number is not shown, type it into
the edit box. You can find your Authorization number in print and
Braille on your MAGic CD sleeve.

Press ENTER to continue. You will be asked to connect to the
Internet if you have not already done so. You must establish an
Internet connection before continuing with the activation.

If you have not registered MAGic, you are asked to do so now.
Registering MAGic lets you receive technical support. Choose
Register Now and complete the online registration form by
following the instructions provided. You can choose to register
later, but you must register the next time you activate MAGic.

After you submit your registration, Internet License Manager
attempts to activate MAGic. This process may take several
minutes. When the activation is successful, choose Finish.

Note:

If Internet License Manager cannot activate MAGic because of
your firewall software, see Troubleshooting Firewall Software
on page 7.




Troubleshooting Firewall Software

Firewalls protect computer systems from being accessed by
unauthorized users. Some network or personal firewall software may
interfere with the installation, activation, or usage of MAGic. The
following information will help you reconfigure your firewall to work
with MAGic. Refer to your firewall software documentation for more
information on allowing access for programs and files.

Note: Hardware firewalls do not interfere with installing, activating,
or running MAGic.

Firewall Interferes with Installation

If your firewall software is preventing you from installing MAGic on your
computer, reconfigure the firewall to allow the file Setup.exe to run.
Then retry the installation procedure.

Firewall Interferes with Activation

If your firewall software prevents you from activating MAGic using the
Internet, reconfigure the firewall to allow the following files to run:
FSActivate.exe, CAUtil.exe, and CAUtil.enu. Once you have reconfigured
your firewall, retry the activation process. If you cannot reconfigure the
firewall, or if you still cannot activate MAGic, go to www.FSActivate.com.
Follow the instructions on the Web page to retrieve an Activation
License code and activate your software. For more information on using
www.FSActivate.com, see Activating through a Trusted Third Party on
page 10.

Firewall Interferes with Using MAGic

If the firewall software prevents MAGic from running or starting, or
displays a warning message, reconfigure the firewall to allow the file
JFW.exe to run.

Advanced Troubleshooting Information

For a complete list of all files that need to be allowed by your firewall
software, including the connection type, incoming port, and outgoing
port, refer to Advanced Troubleshooting in the MAGic Online Help.
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Activating by Telephone

If you do not have an Internet connection, you can call Freedom
Scientific Customer Service. Customer Service will send you a CD in the
mail that will automatically activate MAGic.

When you first start MAGic, you are asked to activate the program. You
can also begin the activation process by opening the Help menu and
choosing Update Authorization. To activate MAGic by telephone, do the
following:

1.
2.

In the Activation dialog box, choose Start Activation.

Read the message that displays and then choose Continue. Insert
the Authorization CD into your CD-ROM drive and choose Activate
Using Authorization CD. You can find your Authorization CD in the
same sleeve as your MAGic program CD. If you do not have your
Authorization CD, choose Enter Your Authorization Number
Manually.

Note:

If you have previously inserted your Authorization CD, you
will not be asked to insert it again. Continue to step 3 of the
activation.

Choose Activate.

Use the arrow keys to select Telephone to Receive Activation by
Mail, and then press ENTER.

Call (727) 803-8015. Provide the customer service representative
with the Authorization number and Locking code shown in this
dialog box. If your Authorization number is not shown, you can
find it in print and Braille on your MAGic CD sleeve.

Choose Quit. You can continue using MAGic in 40 minute mode
until you receive your CD.

When you receive the CD with your Activation License code from
Freedom Scientific, insert it into your CD-ROM drive to automatically
activate MAGic.



Note:

If the CD does not automatically activate your software, press
WINDOWS Key+R, type "D:\ActivationCode.exe" and press
ENTER. If your CD-ROM drive is not D:, then substitute the
correct letter.

Activating by Fax

If you do not have an Internet connection, you can send a fax to
Freedom Scientific with your Authorization number and Locking code.
You will then receive an Activation License code either in an e-mail
message or on a CD.

When you first start MAGic, you are asked to activate the program. You
can also begin the activation process by opening the Help menu and
choosing Update Authorization. To activate MAGic by fax, do the
following:

1.
2.

In the Activation dialog box, choose Start Activation.

Read the message that displays and then choose Continue. Insert
the Authorization CD into your CD-ROM drive and choose Activate
Using Authorization CD. You can find your Authorization CD in the
same sleeve as your MAGic program CD. If you do not have your
Authorization CD, choose Enter Your Authorization Number
Manually.

Note:

If you have previously inserted your Authorization CD, you
will not be asked to insert it again. Continue to step 3 of the
activation.

Choose Activate.
Use the arrow keys to select Fax, and then press ENTER.

Complete the form by typing the required information into the edit
boxes. If you want to receive your Activation License code in an e-
mail message, enter your e-mail address. If you do not enter an e-
mail address, Freedom Scientific will send you a CD in the mail
that will automatically activate MAGIC.



6. If you used your Authorization CD, your 20-digit Authorization
number is automatically inserted into the Authorization Number
edit box. If your Authorization number is not shown, type it into
the edit box. You can find your Authorization number on your
MAGIC CD sleeve.

7. Choose Print to send the form to your printer. After you have
printed the form, choose Quit.

8.  Fax the printed form to (727) 803-8001.

If you entered your e-mail address, you should receive an e-mail
message from Freedom Scientific within one or two business days.
Follow the instructions provided in the message to activate MAGIC. If
you do not enter an e-mail address, you will receive a CD from Freedom
Scientific in the mail. Insert the CD into your CD-ROM drive to
automatically activate MAGIC.

Note: If the CD does not automatically activate your software, press
WINDOWS Key+R, type "D:\ActivationCode.exe" and press
ENTER. If your CD-ROM drive is not D:, then substitute the
correct letter.

Activating through a Trusted Third Party

If you know a friend, relative, or other trusted person with an Internet
connection, they can help you activate MAGic. Alternatively, you can use
an Internet connection in a library, at work, or anywhere else. You or a
trusted third party can visit www.FSActivate.com to obtain your
Activation License code.

Tip: A free program from Freedom Scientific called Activation
Media Image Creator lets you create a CD, 3.5-inch disk, or e-
mail attachment containing MAGic license information.

To obtain an Activation License code from FSActivate.com, do the
following:

1.  Point your Web browser to http://www.FSActivate.com.

10
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Enter your 20-digit Authorization number and Locking code. Your
Authorization number appears on your MAGic CD sleeve in both
print and Braille. To find your computer's Locking code, open the
MAGic Help menu and choose About.

Note:

The Locking code is unique for each individual computer. Be
sure you enter the Locking code of the computer you intend
to use with MAGic when it is activated.

Choose Submit License Request to receive an Activation License
code.

The remaining steps must be completed on the computer where
the copy of MAGic you want to activate is installed. Begin by
starting MAGic on this computer. From the MAGic Help menu,
choose Update Authorization.

In the Activation dialog box, choose Start Activation.

Read the message that displays and then choose Continue. Insert
the Authorization CD into your CD-ROM drive and choose Activate
Using Authorization CD. You can find your Authorization CD in the
same sleeve as your MAGic program CD. If you do not have your
Authorization CD, choose Enter Your Authorization Number
Manually.

Note:

If you have previously inserted your Authorization CD, you
will not be asked to insert it again. Continue to step 7 of the
activation.

10.

Choose Activate.

Use the arrow keys to select the Activation Generated from
www.FSActivate.com radio button and press ENTER.

Type the Activation License code you received from
www.FSActivate.com into the edit box and then press ENTER.

After you have successfully activated MAGic, choose Finish to
complete the process.

11
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Using Activation Media Image Creator

Activation Media Image Creator is a free program from Freedom
Scientific that allows a user with an Internet connection to retrieve
Activation License codes from Internet License Manager. The user can
then distribute these Activation License codes on CD, 3.5-inch disk, or
e-mail. Users without Internet connections can use the files created by
this program to activate MAGic without having to type the lengthy
Activation License code.

To download the installation package for Activation Media Image
Creator, visit www.FSActivate.com. After you install the program, follow
the instructions in the Activation Media Image Creator online Help to
retrieve and distribute Activation License codes from Internet License
Manager.

Dongle Authorization

A dongle is a hardware device that you can connect to a computer's
parallel or USB port (depending on the type of dongle). MAGic is
authorized to run on that computer as long as the dongle remains
connected. This is useful if you frequently need to use MAGic on many
different computers and do not want to activate the program on each of
them.

When MAGic starts, it first determines whether a dongle is connected to
the computer. If one is connected, MAGic uses the features and
information for the license associated with the dongle to authorize
MAGic. If no dongle is connected, MAGic searches for the license
information stored on the computer. You can use the Dongle Viewer
utility to view information on the license associated with the dongle
currently connected to your computer. To start this utility, go to the
MAGic program group, open the Tools submenu, and choose Dongle
Viewer.

Note: Itis recommended that you do not connect the dongle to
your computer until after you install MAGic. If the dongle was
connected before or during installation, you must restart your
computer to receive proper authorization.

12
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Dongles are sold separately or as an additional MAGic feature. Contact
Freedom Scientific Sales if you want to purchase one.

Note: Certain international versions of MAGic require a dongle for
authorization. Using one of these versions without a dongle

displays an error message.

3.5-inch Disk (Quella) Authorization

If your version of MAGic uses a 3.5-inch disk for authorization instead of
Internet License Manager, this section will help you authorize your
software.

The authorization key contains the information your computer needs to
run MAGic. MAGic prompts you for either an authorization disk or an
update disk, if you received one. Follow the instructions that appear on
the screen to complete your authorization of MAGic. The first time you
start MAGic, you are asked to register your software.

MAGic Program Group

To see the MAGic program group, click the Start button and choose
Programs, MAGic. The contents of the MAGic program group display in
the MAGic submenu.

|j Tools k

& FoReader Demo
E@ Help
M MaGic

s Miew Readme. bxt

rj Explore MaGic »

13



Within the MAGic program group, you will find the following:

FSReader Demo - Starts FSReader Demo. This program allows you
to listen to DAISY books created by Freedom Scientific. The MAGic
Basic Training is available in DAISY format. You can install this
book when you install MAGic. After you start FSReader, open the
File menu and choose Open. You can listen to the included
"FSReaderGettingStarted" DAISY book to learn how to use the
program.

Help — Opens the online help system.
MAGic — Launches the MAGic program.

View Readme.txt — The MAGic Readme.txt contains important
information regarding installing and uninstalling MAGic, starting
MAGic, technical notes and known issues, video card compatibility,
and contact information for Freedom Scientific.

Tools Folder
This folder contains the following MAGic utilities:
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Dongle Viewer — Allows you to view license information for the
dongle currently connected to your computer. For more
information on using a dongle to authorize MAGic, refer to Dongle
Authorization on page 12.

Installation Maintenance — Allows you to modify, repair, or remove
MAGic. Use the Modify option to change the languages that you
have installed with MAGic. This is also a useful setting for
troubleshooting. Use the Repair option to reinstall MAGic. Use the
Remove option to uninstall MAGic from your system.

MAGic Network Administrator - Network administrators use this to
add, delete, and modify user settings of MAGic in a network
environment.

Uninstall MAGic — Used to uninstall MAGic from your computer.

ILM Authorization Viewer - Allows you to view details of your ILM
software licenses.



Remove Product Activation - Allows you to delete your ILM
licenses for all versions of MAGic installed on this computer. Until
you acquire a new license, you will only be able to use MAGic in 40
minute mode.

Video Intercept Manager - Allows you to install/uninstall Video
Intercept and displays information about your computer’s display
adapter, video chain, and Display Chaining Manager (DCM)
compliant drivers.

Explore MAGic

This folder provides shortcuts to folders containing your user settings,
shared settings, and program files.

Explore My Settings - Opens the folder containing your user-
specific MAGic settings. When you create new schemes or modify
factory schemes, MAGic saves them in this folder. Your custom
settings are also saved in this folder.

Explore Program Files - Opens the folder where you installed
MAGic, allowing you to access the program files.

Explore Shared Settings - Opens the folder containing your shared
MAGic settings. Factory schemes and default factory settings are
saved in this folder.

Starting MAGic

MAGic gives you a variety of ways to start the program.

Press the hot key, ALT+CTRL+M, which can be automatically
assigned when you install MAGic.

Double-click the MAGic icon on your desktop.

From the Start menu, choose Programs, open the MAGic submenu,
and choose MAGic.

After you start MAGic for the first time, you can choose to run the
program when Windows starts. To do this, open the File menu, choose
Preferences, and select the Run MAGic at Startup check box.
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Quitting MAGic
To quit MAGic, do one of the following:
e Press ALT+F4

o Click the & in the top right hand corner of the window.
e Select Exit from the File menu.

Tip: If you want MAGic to ask you to save your settings when you
quit, open the File menu and choose Preferences. Select the
Prompt to Save Settings on Exit check box.

Overview of MAGic for New Users

Start MAGic by pressing ALT+CTRL+M or by double-clicking the MAGic
program icon on your Windows desktop. You can also start MAGic by

opening the Start menu, choosing Programs, MAGic and then selecting
MAGic.

When you first start MAGic, your screen is displayed in 2x magnification
using the Full view. Speech will also be enabled. You can change the
magnification level, magnified view, speech, and many other options by
using the MAGic user interface.

The user interface is a small window that allows you to control all
aspects of MAGic. This window contains the magnification and speech
buttons in addition to the MAGic menu and title bars. The user interface
is shown below.

For more information on the MAGic user interface, please refer to
Chapter 3 User Interface.
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Magnification and Speech Buttons

One of the first things you will notice about the user interface are the
rows of blue and orange buttons. The blue buttons control magnification
features while the orange buttons control speech. Below are brief
descriptions of each button.

Button Function

Use the Magnification button to enable or disable
magnification.

The current magnification level can be adjusted with
the two Magnification Level buttons. The number in the

o)
u box shows the current magnification level.

Use the Mouse Enhancements button to enable/disable
enhancements and modifications for your mouse
pointer. These enhancements make the mouse pointer
easier to track and maneuver on your screen.
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Button

Function

Use the Cursor Enhancements button to enable/disable
enhancements for your cursor. These enhancements
make the cursor easier to follow when editing or
writing text.

Use the Color Enhancements button to enable/disable
color enhancements. This feature allows you to replace
colors, adjust the brightness and contrast, apply
tinting, and invert the brightness and colors of your
display.

Use the Locator button to enable/disable the Locator
function. The Locator function allows you to find items
on your screen.

Use the Smoothing button to enable/disable
smoothing. This feature smoothes the appearance of
jagged letters in a magnified state.

The Resize View button allows you to change the
dimensions of your magnified view.

Select your preferred magnified view from the
Magnified Views list.

Use the Speech button to enable or disable speech.

1@[@1@ 8 B

Use the Mouse Echo button to toggle the mouse echo
feature on and off. Mouse echo enables MAGic to read
text that you point at with the mouse.

Use the Typing Echo button to enable or disable typing
echo. If typing echo is enabled, MAGic announces the
words or characters you type.
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MAGic Menus

Located above these buttons is the menu bar. The menu bar allows you
to customize speech, magnification, and your keyboard. You can also
view help information and perform other functions. Each menu is
described below.

|Ei|e Magnification Speech  kevboard Help |

Menu

Purpose

File

The File menu allows you to save your settings and

restore the original Freedom Scientific settings. You can

also use this menu to change your MAGic preferences.

Magnification

The Magnification menu allows you to customize how

you view your screen with MAGic. You can also change
mouse options, panning settings, view properties, and
more.

Speech

You can customize MAGic’'s speech components to fit
your particular needs. The Speech menu allows you to
customize how you read text with MAGic.

Keyboard

The Keyboard menu allows you to customize how you
use your computer’s keyboard with MAGic. You can re-
assign the MAGic Key to a different key or manage
shortcut keys.

Help

The Help menu provides you with detailed help
information for the various MAGic functions and
options. You can also view information on the newest
features for this release and see your current MAGic
version.
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Most of these commands display a dialog box that allows you to

customize certain aspects of MAGic. You can press F1 or use the
button to get help on any option in the dialog box. From the MAGic user
interface, you can select Help Topics from the Help menu to view the
complete online help system which provides a full-text search, index,
and table of contents to help you find the information you need. For
more information on MAGic Help, refer to Getting Help on page 28.

The MAGic Key

The MAGic Key is the CAPS LOCK key on your keyboard. Pressing the
MAGic Key in combination with other keys activates a number of MAGic
commands. If you want to assign the MAGic Key to a different key on
your keyboard, open the Keyboard menu and choose MAGic Key. For
more information, refer to MAGic Key on page 96.

Hot Keys

In addition to the menus and magnification/speech buttons, there are a
number of keyboard hot keys you can use at any time to read text,
change how MAGic magnifies your screen, or perform a variety of other
functions. For a complete list of hot keys, refer to Appendix C MAGic Hot
Keys on page 131.

Reading Text with MAGic

MAGic can use synthesized speech to read text that appears on your
screen, including documents, menus, dialog boxes, e-mail messages,
Web pages, and more. Additionally, MAGic can highlight the text as it is
spoken. To customize MAGic’'s speech, use the commands available on
the Speech menu.

Tip: You can silence MAGic's speech at any time by pressing CTRL.
To toggle speech on or off, press MAGic Key+F3.
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Using the Mouse to Read Text

Mouse echo is a feature that allows you to read text with your mouse.
To use mouse echo, just move your mouse pointer to some text on your
screen and then stop. After a short delay, MAGic will speak the word you
pointed to. You can use the Mouse Echo button to enable or disable this
feature. For more information, refer to Mouse Echo on page 84.

In addition, you can hold down the MAGic Key and press the left mouse
button to start reading from the current location of the mouse pointer.
You do not need to hold down the MAGic Key while MAGic reads. MAGic
stops reading when you move the mouse or press a key.

Using the Keyboard to Read Text

MAGic has a number of different keystrokes that let you use the
keyboard to read text. To use these keystrokes, move the insertion point
or mouse pointer to any location within the document. Then press one
of the following key combinations to read from that location:

e To begin reading from your current location, press MAGic
Key+SPACEBAR or INSERT+DOWN ARROW.

e To read the current character, press NUM PAD 5.

e To read the current word, press MAGic Key+ALT or INSERT+NUM
PAD 5. To spell the current word, press the keystroke twice
quickly.

e To read the next word, press INSERT+RIGHT ARROW. To read the
previous word, press INSERT+LEFT ARROW.

e To read the current line, press MAGic Key+L or INSERT+UP
ARROW. To read the next line, press DOWN ARROW. To read the
previous line, press UP ARROW.

e To read from the beginning of the line to the current position of
the cursor, press INSERT+HOME. To read from the current position
of the cursor to the end of the line, press INSERT+PAGE UP.

e To read the current sentence, press MAGic Key+S. To read the next
sentence, press CTRL+MAGic Key+S.
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e To read the current paragraph, press MAGic Key+P. To read the
next paragraph, press CTRL+MAGic Key+P. To read the previous
paragraph, press ALT+MAGic Key+P.

e To begin reading a column of text from your current location, press
MAGic Key+C.

e To read text that you have selected, press MAGic Key+CTRL or
INSERT+SHIFT+DOWN ARROW.

e To hear the contents of the Clipboard, press MAGic Key+X.

Note: By default, the MAGic Key is assigned to the CAPS LOCK key.
To change this, open the Keyboard menu and choose MAGic
Key. Refer to MAGic Key on page 96 for more information.

When you read text with these keystrokes, MAGic highlights the word it
is currently speaking. To change the color and/or style of this
highlighting, open the Speech menu and choose Document and Text
Reading. For more details, see Document and Text Reading on page 93.

Reading Text in Dialog Boxes

In addition to the reading commands listed previously, you can use the
following keystrokes to hear information in Windows dialog boxes:

e To read the title bar of the active window or dialog box, press
MAGic Key+T or INSERT+T.

e To read the bottom of the active window (which usually contains
the status bar), press INSERT+PAGE DOWN. To read the top line of
the active window (which usually contains the title bar), press
INSERT+END.

e To hear the name of the default button that will be activated when
you press ENTER, press INSERT+E.

e To read the currently selected dialog box option (such as an edit
box or check box), press MAGic Key+TAB or INSERT+TAB.

e To hear the access key for the currently selected dialog box option,
press SHIFT+NUM PAD 5.

22



Typing Echo

If typing echo is enabled, MAGic repeats each character or word that you
type. MAGic also speaks the character to the right of the insertion point
when you use the arrow keys to move through text. You can use the
Typing Echo button to enable or disable this feature. For more
information, refer to 7yping Echo on page 85.

Saving your MAGic Settings

If you adjust any of the magnification, speech, or other settings in the
various dialog boxes, you must save your changes if you want MAGic to
use those settings the next time it starts. To save your current settings,
open the File menu and choose Save Default Settings or press CTRL+S.
These default settings are applied whenever there are no application-
specific settings for the program you are using. If you do not save your
settings, your changes will be discarded when you quit MAGic.

Tip: MAGic can ask you whether you want to save your changes
when you quit the program. To enable this feature, open the
File menu and choose Preferences. Then, select the Prompt
to Save Settings on Exit check box.

You can recall your default MAGic settings at any time. To do this, open
the File menu and choose Open Default Settings or press
CTRL+SHIFT+D. These default settings replace your current settings.

Application-Specific Settings

Your usual magnification and speech settings may not be suited to all
programs that you use. For this reason, MAGic allows you to save
specific groups of settings that are automatically applied while you use
certain programs. These are referred to as application-specific settings.
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For example, if you prefer greater magnification when surfing the
Internet, you could create and save settings that are only applied while
you are using Internet Explorer. Whenever you are working with Internet
Explorer, MAGic will increase the level of magnification. When you quit
Internet Explorer or switch to a different program, MAGic will reduce the
magnification level. Application-specific settings make it easy to
customize MAGic to work well with all of your favorite programs.

To save a group of application-specific settings for a program, do the
following:

1.  Start the program that you want to create application-specific
settings for.

2.  From the File menu or the MAGic Context Menu, choose Create
Application Settings (where the word Application is the name of
the program you are saving settings for).

Tip: The program name displayed on the menu is the last program
you used before switching to MAGic. If you are using the
MAGic context menu, the program is the one that is currently
active. Make sure that the correct program name appears on
the menu before creating or saving your settings.

3. Type a name for the application-specific settings file, or use the
suggested name. Then, choose OK to create the file.

4. Use the MAGic menus and dialog boxes to select the magnification
and speech options that you want to use for this program.

5.  From the File menu, choose Save Application Settings (where the
word Application is the name of the program you are saving
settings for).

The next time you start this program, MAGic will automatically apply the
settings you have selected. If you switch to a different program, MAGic
returns to your default settings or the settings you have chosen for the
other program. When you quit the program, MAGic applies your default
settings.
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Modifying Application-Specific-Settings
If you want to change your current application-specific settings for a
program, do the following:

1.  Start the program that you want to modify your application-
specific settings for.

2. Use the MAGic menus and dialog boxes to select the magnification
and speech options that you want to use for this program.

3.  From the File menu, choose Save Application Settings (where the
word Application is the name of the program you are saving
settings for).

Managing Application-Specific Settings

You can easily see which programs you have created application-specific
settings for. To do this, open the File menu and choose Manage
Application Settings. The Manage Application Settings dialog box
appears, showing all programs with defined application-specific
settings.

Manage Application Settings E|[z|

Application 5ettingz

& Internet Explarer 5-6

[w] Microgaft Outlook =P-2003
[w]tMicrogoft "Word

Enable &l | Disable 4l | Remove Selected |

s | Cancel |

If you no longer want MAGic to use the settings you have defined for a
program, clear the check box next to the program's name. To quickly
clear all the check boxes, choose the Disable All button. You can re-
enable any group of application-specific settings by selecting the check
box next to the program's name. To quickly select all the check boxes,
choose the Enable AUl button.

25



To delete an application-specific settings file, select it in the list and
then choose the Remove Selected button.

Changing your Preferences

From the File menu, choose Preferences to change the way you use
MAGic on your computer. You can use this dialog box to start MAGic
when your computer starts, disable your screen saver while MAGic is
running, minimize MAGic when it starts, enable/disable the bilingual
user interface, specify whether MAGic should prompt you before
overwriting schemes, and determine whether MAGic asks you to save
your settings when you quit. After you close this dialog box, you must
choose Save Settings from the File menu to save any changes you made
to your preferences.

Preferences  [2)X)

[ Minimize on Startup

[ Bun MAGic at Startup

[ Run MAGic from System Tray

[ Prompt bo Save Settings on Exit
[v Disable Screen Saver

[ Enable Bilingual Interface

v Prompt to Ovenwrite Schemes
| Enforced ‘wiite Pratect

[ Prompt Scheme Demo at Startup

Cancel |

Minimize on Startup

If you select the Minimize on Startup check box, the MAGic user
interface will be minimized when you start the program. Click MAGic
Screen Magnification in the taskbar or press MAGic Key+U to display the
user interface.

Run MAGic at Startup

If you select the Run MAGic at Startup check box, MAGic automatically
starts when you start Windows.
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Prompt to Save Settings on Exit

Select the Prompt to Save Settings on Exit check box if you want MAGic
to ask you to save your settings when you quit the program or shut
down your computer. If you do not select this check box, you must press
CTRL+S or open the File menu and choose Save Settings to save your
settings.

Disable Screen Saver

Select the Disable Screen Saver check box if you want to prevent your
screen saver from starting while MAGic is running. Your screen saver
will be enabled again when you quit MAGic.

Enable Bilingual User Interface

Select the Enable Bilingual User Interface check box to change the
language of MAGic’'s menus, dialog boxes, and online help system when
you switch to a voice profile that uses a different language. The
resource files for the language must be installed in order to use this
feature. Clear this check box if you do not want to change the language
of MAGic’s user interface when you switch to a voice profile that uses a
different language.

Note: The current release of MAGic contains only English and
Spanish resource files.

Prompt to Overwrite Schemes

Select the Prompt to Overwrite Schemes check box if you want MAGic to
ask for confirmation before saving a mouse, cursor, or color
enhancements scheme with the same name as an existing scheme. If
you do not select this check box, MAGic will save the new scheme over
the old scheme without asking for confirmation.

Note: Different types of schemes can have the same name. For
example, a cursor enhancement scheme can have the same
name as a mouse enhancement scheme.
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Run MAGic from System Tray

Select the Run MAGic from System Tray check box if you do not want
the MAGic window to appear in the Windows taskbar with other
programs that you are currently using. In addition, the MAGic window
does not appear in the list of active windows when you press ALT+TAB.
An icon appears in the Windows system tray (located in the bottom right
corner of the screen) to indicate that MAGic is running. Double-click this
icon or press MAGic Key+U to display the MAGic program window. If you
minimize the MAGic window, it is removed from the taskbar again.

Note: You must restart MAGic before any change to this option can
take effect.

Enforced Write Protect

It is recommended that you leave the Enforced Write Protect check box
cleared if you use your computer for multi-session work, such as
Citrix/Terminal Services remote access or fast user switching. You
should also leave this check box cleared if your network administrator
uses service management software to install updates or make changes
to your computer remotely. If you select this check box, your network
administrator cannot update or modify MAGic files remotely.

Prompt Scheme Demo at Startup

Select this check box if you want MAGic to display a message at startup
asking whether you want to enable the verbosity scheme demonstration
mode. This mode allows you to try using verbosity schemes with MAGic.
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Getting Help
Online Help System

To access MAGic's online help system, select Help Topics from the Help
menu, which is located on the menu bar of the MAGic application
window. Use the Contents tab to navigate the help system. Use the
Index or the Search tabs to search for specific topics within the help
system. If you want MAGic to read the help topics to you, position the
mouse pointer toward the beginning of the help page, and press MAGic
Key+SPACEBAR. You can move to the next topic by clicking the "Next"
link at the bottom of the page. To return to the previous topic, click the
"Back" link.

What's This? Help

MAGic's What's This? help is context-sensitive help that you can use as
a reference when working with MAGic's user interface or dialog boxes.
Press SHIFT+F1 on any button on the user interface, or control in a
dialog box to see a brief description of the purpose of the control and
how to use it.

MAGic User’'s Guide

We provide you with the content of the MAGic online help system in the
MAGic User’s Guide, which is printed in large text for easier reading.
This book contains detailed descriptions of MAGic's features, and also
pull-out reference cards.

MAGic Basic Training

Listen to the MAGic Basic Training to learn the fundamentals of using
MAGic Screen Magnification. For more information, see Basic Training
on page 30.

Technical Support

If you do not find the answers to questions or problems that you have,
contact Freedom Scientific Technical Support, (727) 803-8600.
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About MAGic

Select About MAGic from the Help menu on the MAGic user interface to
view the version number of MAGic you are currently running.

Basic Training

The basic training for MAGic is included in DAISY format on your MAGic
program CD. When you install MAGic, you are also asked if you want to
install these materials. You can listen to and read the training modules
by using the FSReader Demo DAISY reader included with MAGic. To start
FSReader Demo, open MAGic Help menu and choose Training.

After you start FSReader Demo, a list of all DAISY books in the current
folder appears. For more information on using FSReader, select the
"FSReaderGettingStarted" DAISY book and choose Open.

To begin the basic training, do the following:

1.  If the FSReader Open dialog box is displayed, choose Cancel.
2. Insert your MAGic 10.0 program CD into the C-ROM drive.

3. In FSReader, open the File menu and choose Open.

4. Select the "MAGicBasicTraining" DAISY book and choose Open.
This training is designed to give you a basic overview of MAGic. You will
learn how to change your magnification and speech preferences, along

with several other techniques. All users are encouraged to take
advantage of this training.
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Chapter 2
Navigating MAGic

Use Your Mouse and Your Keyboard

With MAGic, you can use both your mouse and your keyboard to access
most features. You decide what is best for you. Many people use a
combination of the two. The MAGic documentation gives you
information on how to perform actions with both the keyboard and the
mouse. For example, you can either press ALT+F to access the File
menu, or you can point and click the word File with the mouse.

Using the Keyboard with MAGic

The MAGic Key

When you use the keyboard in MAGic, the most important thing to know
is the MAGic Key. The default MAGic Key is the CAPS LOCK key on your
keyboard. Using the MAGic Key in combination with other keys activates
a MAGic command if one is assigned, otherwise it will pass the key
combination through to the application. Pressing the MAGic Key by itself
and releasing it will not carry out any action. You can specify what key
you use for your MAGic Key in the MAGic Key dialog box, which is
activated from the Keyboard menu. Your choices include: Extended
INSERT (found on the six pack), NUM PAD INSERT, either INSERT, or
SCROLL LOCK (the key just above HOME).

Pass the MAGic Key Through

If your MAGic Key is set to the default of CAPS LOCK, how do you use
your CAPS LOCK key as usual?

Press the CAPS LOCK key twice quickly, and caps lock will turn on. To
turn off caps lock, press the key twice quickly. Use this double key press
to pass through any of the MAGic Keys that you use. For instance, if you
select INSERT as your MAGic Key, press the INSERT key twice to use the
actual insert function.
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Pass Through Key Command

If you have an application that uses the same keystroke combination as
one assigned to MAGic, you can pass the keystroke combination through
to the application, so it will not function as a MAGic keystroke in that
instance.

Press MAGic Key+3 (on the numbers row), and then press the keystroke
you want to use in the application. Use the Pass Through command for
any key combination that is used in MAGic and in other applications.

With MAGic, you can customize all of your keystrokes in the Keyboard
Assignments dialog box, activated from the Keyboard menu. If you
specify certain keystrokes for use in MAGic, you may need to use these
keystrokes in other applications. Keep the Pass Through command of
MAGic Key+3 in mind when you customize keystrokes.

Customizing the Keyboard

The Keyboard menu allows you to customize how you use your
computer’s keyboard with MAGic. This menu allows you to re-assign the
MAGic Key to a different key and manage shortcut keys. The Keyboard
menu provides the following options:

e Choose MAGic Key from the Keyboard menu to change which key is
assigned to the MAGic Key.

e Choose Keyboard Assignments from the Keyboard menu to view
the current hot keys assigned to actions, assign different hot keys,
remove hot keys, or restore the hot keys to the default settings.

Refer to Chapter 6 Keyboard for detailed information on these
commands.
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Using the Mouse with MAGic
Point and Click

With MAGic you don’t have to learn keystrokes to perform actions. You
can use the mouse to point at items on the user interface, and click the
buttons to activate features. For example, to enable mouse
enhancements, just point at the Mouse Enhancements button and press
the left mouse button.

If you are not sure how to activate a feature, use your mouse to open
the menus and find the feature you need.

Left Click vs. Right Click

The left mouse button is the more commonly used mouse button,
because it activates buttons and menus. Alternatively, the right mouse
button provides useful shortcuts to many items found under MAGic's
menus.

You can right-click many of the buttons on the user interface to see a
context menu. Depending on where you right-click on the user interface,
the menus change. Use your right mouse button to access the most
common features associated with the buttons on the MAGic user
interface.

Tip: Hold down the MAGic Key and press the right mouse button
to display the MAGic Context Menu. This menu allows you to
quickly access many useful MAGic commands.

If you are not a mouse user, you can activate context menus with the
APPLICATION Key on the keyboard. Locate the APPLICATION Key just to
the left of the right CTRL key in the bottom row on your main keypad.
Use the TAB key to place the focus on the button that you want to see
the context menu for, and press the APPLICATION Key to open the
menu. Then use the UP and DOWN ARROWS to move through the menu
choices.
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Mouse Wheel Commands

If your mouse has a mouse wheel between the left and right buttons,
you can use it to perform a variety of useful MAGic commands:

e Hold down the MAGic Key while rolling the mouse wheel up to
increase the current magnification level.

e Hold down the MAGic Key while rolling the mouse wheel down to
decrease the current magnification level.

e Hold down the MAGic Key and click the mouse wheel (or middle
mouse button) to switch from the current magnification level to 1x
magnification. Perform this command again to switch back to your
previous magnification level.

Using the MAGic Context Menu

The MAGic Context Menu provides you with quick access from any
program to the most commonly used magnification and speech options.
There are also commands that allow you to save your MAGic settings. To
open the MAGic Context Menu, hold down the MAGic Key and either
right-click or press the APPLICATION Key.

Magnification Lewvel
Active Yiew

Mouse Enhancement
Cursor Enhancement

v v v w

Color Enhancement

‘oice Profile
Yerbosity Scheme
Mouse Echo
Typing Echo

v v v

Create Microsaft Wiard Settings
MAGic Main Window
Exit MaGic

To create a new application settings file for the current program, choose
Create Application Settings (where Application is the name of the
program). To access the MAGic user interface, choose MAGic Main
Window. To quit MAGic, choose Exit MAGic. For information on the other
commands available on the MAGic Context Menu, refer to Magnification
Features on page 47 and MAGic Speaks on page 77.
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The MAGic Context Menu closes after you choose a command. If you
want to close the menu without choosing a command, press ESC or click
anywhere outside of the menu.
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Chapter 3
User Interface

The MAGic user interface contains everything you need to customize
magnification and speech to fit your needs. The user interface
automatically opens when you launch MAGic. If you want to make the
user interface active while you are working in another window, click
MAGic Screen Magnification in the Windows taskbar or press MAGic

Key+U.

The MAGic user interface consists of the title bar, the menu bar, and the
Quick Access Window.

File Magnification Speech Kewboard Help

The title bar is the bar across the top of the application, which says,
“MAGic Screen Magnification.” The menu bar is located just below, and
contains the File, Magnification, Speech, Keyboard, and Help menus.
The Quick Access Window is the main area of the user interface.

Title Bar

Locate the MAGic title bar at the very top of the window. It reads,
“MAGic Screen Magnification.” Press MAGic Key+T or INSERT+T to hear
the text of the title bar. If speech is not enabled you will not hear

anything.

m MAGIc Screen Magnification
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Click the M icon on the left side of the title bar, or press ALT+SPACEBAR
to see the control menu, which includes options to Move, Minimize, and

Close. Click the E4 button, or press ALT+SPACEBAR, N to minimize the

application. Click the & in the top right corner, or press ALT+F4, to exit
MAGic.

Menu Bar

The MAGic menu bar contains five menus: File, Magnification, Speech,
Keyboard, and Help.

|Ei|e Maqgnification Speech  Eevboard Help |

Tip:

To open these menus with the keyboard, press ALT and the
underlined letter. For example, press ALT+F to open the File
menu.

The File menu contains the following commands:

Save Default Settings — When you change magnification, speech,
and other options found in the MAGic dialog boxes, select Save
Default Settings to store your preferences for the next time you
run MAGic. These settings are used whenever there are no
application-specific settings available.

Open Default Settings - Choose this command to load your default
MAGic settings.

Create Application Settings - This command allows you to create a
new file containing application-specific settings for the last
program that you used. After you choose this command, you are
asked to type a name for the settings file.

Save Application Settings - This command allows you to save your
current settings in the application-specific settings file for the last
program that you used.

Manage Application Settings - This command allows you to enable,
disable, or delete application-specific settings that you have
saved.
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Tip:

For more information on saving default and application-
specific settings, see Saving Your MAGic Settings on page 23.

e Restore Factory Settings — Select this menu item to reset MAGic

options to the state they were in when you installed MAGic.
Selecting this option returns all features to the original settings,
except hot keys that you customized. Activate the Restore Defaults
button in the Keyboard Assignments dialog box to revert all hot
keys to their original configurations.

Preferences — This command lets you change your preferences for
MAGic. For more information, refer to Changing you Preferences on
page 20.

e Exit — Choose Exit to quit MAGic.

Find information about the Magnification, Speech, and Keyboard menus
in Chapter 4 Magnification, Chapter 5 Speech, and Chapter 6 Keyboard.

Quick Access Window

MAGic’s Quick Access Window provides controls to help you easily
access the main MAGic features. Use the buttons on the user interface
to control both magnification and speech. Left click the button to
activate the feature, and right-click the button to see a context menu
for some of the buttons.

Tip:

If you want to use the keyboard with the Quick Access
Window, press TAB to move through the buttons and options.
Press SPACEBAR to activate the selected button, or press the
APPLICATION Key to open the context menu.
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The Magnification Buttons

Use the blue buttons on the MAGic user-interface to control
magnification.

Magnification Button

Use this button to enable or disable magnification.

Use the Magnification button to turn magnification on or off. If the M on
the magnification button is animated, then magnification is turned off.

Hot Keys

Enable or Disable MAGic Key+DELETE
Magnification

Magnification Level Buttons

Increase or decrease the magnification level with these buttons.

o
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The upper button, with the upward arrow image, increases the
magnification level, while the lower button, with the downward arrow
image, decreases the magnification level. The number between the two
buttons shows the current magnification level. The default level of
magnification is 2% (2x is equivalent to two times the normal screen
display). If you press the TAB key to move into the area where the
number appears, use your UP and DOWN ARROW keys to increase or
decrease magnification.

It is possible to change the magnification level to 1x%. This allows you to
continue using magnification features, such as mouse, cursor, and color
enhancements, while viewing the entire screen area. You can also
choose from nine incremental magnification levels between 1x and 2x
magnification.

Hot Keys

Increase Magnification  MAGic Key+NUM PAD PLUS
or CTRL+EQUALS

Decrease Magnification MAGic Key+NUM PAD MINUS
or CTRL+DASH

Magnified Views List

Select your favorite magnified view from the list on the MAGic user-
interface.

—_—
You can select Full, Lens, Dynamic Lens, Overlay, or Split for your
magnified view. Full magnifies the entire screen, while each of the
others only magnifies a portion of your screen at a time. Right-click the

Magnified Views list to quickly access the properties for the Split, Lens,
Dynamic Lens, or Overlay views.

Mouse Enhancements Button

Apply enhancements to your mouse pointer with this button.
P—
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Use the Mouse Enhancements button to enable/disable enhancements
and modifications for your mouse pointer. These enhancements make
the mouse pointer easier to track and maneuver on your screen. To
specify which enhancements you want to use, open the Magnification
menu and choose Mouse Enhancements.

Tip: You can right-click this button to quickly choose a new mouse
enhancements scheme or customize the appearance of the
mouse in the magnified or unmagnified area of the screen.
For more information on mouse enhancements, refer to
Mouse Enhancements on page 50.

Hot Keys
Toggle Mouse Enhancements MAGic Key+F4

Cursor Enhancements Button

Apply enhancements to your cursor with this button.

Use the Cursor Enhancements button to enable/disable enhancements
for your cursor. These enhancements make the cursor easier to follow
when editing or writing text. To specify which enhancements you want
to use, open the Magnification menu and choose Cursor Enhancements.

Tip: You can right-click this button to quickly choose a new cursor
enhancements scheme or customize the appearance of the
cursor in the magnified or unmagnified area of the screen.

For more information on cursor enhancements, refer to Cursor
Enhancements on page 53.

Hot Keys
Toggle Cursor Enhancements MAGic Key+F8

Note: Cursor enhancements are not available in Windows 95, 98, or
ME.
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Color Enhancements Button

Change how your screen displays colors with this button.

Use the Color Enhancements button to enable/disable color
enhancements. This feature allows you to replace colors, adjust the
brightness and contrast, apply tinting, and invert the brightness and
colors of your display. You can apply color enhancements to the
magnified area, unmagnified area, or both. To specify your color
enhancement settings, open the Magnification menu and choose Color
Enhancements.

Tip: You can right-click this button to quickly choose a new color
enhancements scheme or customize your color enhancements
for the magnified or unmagnified area of the screen. For
more information on color enhancements, refer to Color
Enhancements on page 59.

Hot Keys
Toggle Color Enhancements = MAGic Key+F12

Note: If you are using Windows 95, 98, or ME, choosing the Color
Enhancements button or pressing MAGic Key+F12 inverts the
colors of the screen instead of toggling color enhancements.
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Resize View Button

When working in Split, Overlay, or Lens, or Dynamic Lens views, use the
Resize View button to resize or move the view.

s

You must be in the Split, Overlay, Lens, or Dynamic Lens view, and
maghnification must be active to use the Resize View button. When the
Resize View button is available it appears blue. If it is gray, you need to
turn on magnification, by choosing the Magnification button on the
MAGic user interface. After you choose the Resize View button, notice
that the cursor changes shape, and that MAGic automatically minimizes
the user-interface. The shape of the mouse indicates in which direction
you can click and drag your mouse to move or resize your view.

X

If the pointer appears as an X, like above, it is not positioned over the
view or one its borders. The X indicates that from this position the view
cannot be resized or moved.

2

A bi-directional cross indicates the ability to move the view to a
different location on your screen. Click the view, and while holding the
mouse button down drag the view to another location. Split view only
moves to the top, bottom, left, or right edge of your screen, while you
can move Overlay to any location on your screen.

-

A vertical pointer indicates that resizing will occur in a vertical direction,
larger or smaller.

&

A horizontal pointer indicates that resizing will occur in a horizontal
direction, either larger or smaller.
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A diagonal pointer indicates that resizing will occur in both vertical and

horizontal directions. MAGic only exhibits the diagonal mouse when you
position the mouse over the corner of the view. The diagonal pointer is

only available for the Overlay, Dynamic Lens, and Lens views.

Locator Button

Activate the Locator with this button.

&)

Use the Locator button to activate the Locator, which you can use to find
items on your screen. Move the Locator with your mouse or your arrow
keys. Change the properties of the Locator with the Locator Properties
dialog box, which you can access from the Magnification menu. Also you

can right-click the Locator button to change the style and border of your
Locator.

Hot Keys
Enable Locator Mode MAGic Key+F10
Disable Locator Mode ESC

Smoothing Button

Toggle Smoothing on or off with this button.

(&)

Choose the Smoothing button to smooth the appearance of jagged

letters in a magnified state. Choose the button again to turn smoothing
off.
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The Speech Buttons

The three orange buttons at the bottom right of the MAGic user-
interface allow you quick access to MAGic’s speech capabilities. From
here, you can enable or disable speech, mouse echo, and typing echo.

Speech Button
Click this button to enable or disable speech.

If the button appears with the mouth opened, like this one, then speech
is enabled.

*
If the button appears with the mouth closed, then speech is disabled.

Right-click the Speech button to switch to a different voice profile or
customize MAGic's individual and global voices.

Hot Keys
Toggle Speech MAGic Key+F3

Mouse Echo Button
Click this button to toggle the Mouse Echo.

If the button appears with white lines to the right, mouse echo is turned
off.

If the button appears with black lines to the right, mouse echo is turned
on. To set mouse echo to announce lines or words, right-click the button
and make your selection from the context menu. You can also set
mouse movement to stop speech from this context menu.
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Hot Keys
Mouse Echo Toggle MAGic Key+M

Typing Echo Button
Click this button to toggle the Typing Echo on and off.

If the Typing Echo button appears to have white lines extending from
the right side, then typing echo is turned off.

If the Typing Echo button has black lines extending from the right side,
then typing echo is turned on. To specify the typing echo to words or
characters, you need to activate the Typing Echo dialog box from the
Speech menu, or right-click and choose Automatically Speak. Choosing
Keystrokes to Echo lets you modify how much MAGic echoes back to
you.
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Chapter 4
Magnification

Magnification Features

With MAGic's extensive magnification features, you can customize your
display to fit your low vision needs.

The Magnification menu, found on the menu bar, contains all of the
controls to change the appearance of your display.

Magnification

v Enable Magnification
Display. ..
Mouse Enhancements. .,
Cursor Enhancements., ..
Color Enhancements. ..
Yiew Properties...
Cwick Miew Frame. .,
Locakor, ..
Panning...
Tracking. ..

The first item on the Magnification menu, Enable Magnification, lets you
activate or deactivate magnification. If the menu item appears with a
checkmark next to it, magnification is enabled. If there is no checkmark,
magnification is disabled.

Remember that the blue buttons on the user-interface allow you quick
access to the basic magnification features.
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The Magnification Menu
Display

From the Magnification menu, choose Display to change the magnified
view, magnification level, amount of vertical stretch, and text
smoothing.

Wiew: Split - |
tagnification Lewvel: e El:

Yertical Stretch: DE:

[v Smooth Test

Cancel |

View

Select the magnified view you want to use. Each view is described
briefly below.

Tip: To change the properties for these views, open the
Magnification menu and choose View Properties.

e Full magnifies the entire screen.

e Lens opens a small rectangular window, which is magnified, while
leaving the remaining desktop unmagnified. The lens moves
around the screen as you move your mouse or when the focus
moves.

e Overlay creates a magnified window on the corner of the screen,
while the rest of the screen remains unmagnified. This is similar
to the Lens View, although the Overlay View does not move around
the screen.
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e Dynamic Lens opens a small rectangular window, which is
magnified, while leaving the rest of the screen unmagnified. This
window follows the mouse pointer or your current location within a
document or dialog box if you are using the keyboard. In addition,
when you move to a dialog box option or menu command, MAGic
automatically resizes the lens so that it only magnifies the
currently selected item.

o Split allows you to see both an unmagnified area and a magnified
one at the same time. The Split View opens a magnified window
on part of your screen, but leaves the other part unmagnified as a
reference.

Views with Level 1 Magnification

You can use all of the magnified views in any magnification level,
including 1x. Using these views with level 1 magnification can be
helpful if you invert the colors of either the magnified or unmagnified
area. You then have two images, one with normal colors, and one with
inverted colors.

To quickly switch from your current magnification level to 1x
magnification, press MAGIC Key+SHIFT+DELETE. You can carry out this
command again to switch back to your previous magnification level.

Magnification Level

Press the UP or DOWN ARROW keys to increase or decrease the current
magnification level. Magnification levels range from the same size as
the normal display, all the way up to 16 times the size of the normal
display.

Tip: You can choose from nine incremental magnification levels
between 1x and 2x magnification.
Vertical Stretch

Vertical stretch allows you to stretch the display to make images taller
while maintaining the character’s current width.
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Smooth Text

Smoothing compensates for the stair-step effect that occurs as screen
objects get larger during magnification. Smoothing is on by default. You
can turn smoothing on or off with the Smoothing check box.

Mouse Enhancements

From the Maghnification menu, choose Mouse Enhancements to control
the appearance of your mouse in the magnified and unmagnified areas
of your screen. Mouse enhancements make the mouse pointer easier to
track and maneuver on your screen. The Magnified Area and
Unmagnified Area tabs provide the same enhancement options.

The Mouse Schemes tab lets you save your cursor enhancements
settings as a scheme or switch to a different scheme. For more
information on schemes, refer to Using Schemes on page 53.

Select the Enable Mouse Enhancements check box on any of the tabs in
this dialog box to apply enhancements to the mouse pointer. Clear this

check box to disable mouse enhancements. You can also use the Mouse
Enhancements button to enable or disable mouse enhancements.

Mouse Enhancements

Magnified Area l nmagnified Area ] Mouze Schemes ]

Iv Enable Mouze Enhancements

Mouse Attributes

Colar: ||:| Light Blue j Transparency:
Define Cuztarn Calar... || Size: |Standard -

touze Enhancement Attributes

Style: |Shu:urt Crogzhair j Trangparency. 0000 000000000g
Thickness: |_
Color: | Light Bluie =] -
Drefine Cugtom Color. .. || Lenagth: l_
Dizplay: |M|:uuse b oving ﬂ Height: I_

Cancel | Apply |
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Mouse Attributes

The options in the Mouse Attributes area allow you to customize the
appearance of your mouse pointer.

Color

Select a color for your mouse pointer in the Color list. To use the
original system colors for the mouse pointer, choose Original. To invert
the brightness or colors of screen areas covered by the mouse pointer,
choose Invert Brightness or Invert Colors.

To choose from additional colors, activate the Define Custom Color
button and choose one of the available colors from the palette.

Transparency

Use the Transparency slider to adjust the transparency level of the
mouse pointer. A higher level of transparency allows you to see text and
images beneath the area covered by the mouse pointer.

Note: You cannot change the transparency if you are using Windows
95, 98, or ME.

Size

You can use the Size list to increase the proportions of the mouse
pointer. Choose from standard size or large size.

Mouse Enhancement Attributes

Enhancements are used to further modify the mouse pointer by making
it easier to locate and maneuver on the screen.

Style

In the Style list, choose one of the following enhancement types to
apply to your mouse pointer:

e Short Crosshair - Displays intersecting horizontal and vertical bars
that are centered on your mouse pointer. You can adjust the size
of these bars by using the Length and Height sliders.
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e Long Crosshair - This style is similar to short crosshair, but the
horizontal and vertical bars extend to the edges of the view.

e Oval - Displays an oval around the mouse pointer. You can adjust
the size of the oval by using the Length and Height sliders.

e Box - Displays a box around the mouse pointer. You can adjust the
size of the box by using the Length and Height sliders.

e Oval Scope - Combines the short crosshair and oval styles.

e Box Scope - Combines the short crosshair and box styles.

e Long Box Scope - Combines the long crosshair and box styles.
e Long Oval Scope - Combines the long crosshair and oval styles.

Color

In the Color list, choose a color for the enhancement style you selected.
To invert the brightness or colors of screen areas covered by the
enhancement, choose Invert Brightness or Invert Colors. To choose
from additional colors, activate the Define Custom Color button and
choose one of the available colors from the palette.

Display
In the Display list, choose when MAGic should apply enhancements to
the mouse pointer:

e Always - The mouse enhancements are always active and visible
on the screen.

e Mouse Moving - The enhancements are only visible when the
mouse pointer is moving.

e Mouse Not Moving - The enhancements are only visible when the
mouse pointer is stationary.

e When MAGic Key is Pressed - The enhancements only appear when
you press the MAGic Key.

Note: If you are using Windows 95, 98, or ME, the mouse
enhancements are always active and visible on the screen.
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Transparency

Use the Transparency slider to adjust the transparency level of the
mouse enhancement. A higher level of transparency allows you to see
text and images beneath areas covered by the enhancements.

Note: You cannot change the transparency if you are using Windows
95, 98, or ME.

Thickness

Use the Thickness slider to adjust the thickness of the lines of the
enhancement style you selected. Increased thickness makes the
enhancements easier to see and causes them to stand out more.
Decreased thickness causes the enhancements to appear more subdued
and lets you see more of the screen.

Length and Height

Use the Length and Height sliders to adjust the size of the mouse
enhancement style you selected. If you selected the oval, box, long oval
scope, or long box scope style, these sliders let you control the width
and height of the oval or box. If you selected the short crosshair style,
these sliders let you change the length and height of the horizontal and
vertical bars.

Using Schemes

A scheme is a group of settings that can be saved and used in certain
programs or circumstances. Schemes allow you to quickly switch
between different configurations of enhancements, according to your
current needs. For example, you can create a mouse enhancement
scheme specifically for proofreading documents and another scheme for
browsing Web pages.
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Mouse Enhancements E| [z|

kagnified Area ] Urmagnified Area  Mouse Schemes l
[+ Enable Mouze Enhancements
Schemes are aroupings of zethngs for Mouze Enhancements far the magnified and
unmagnified areas of the screen that can be applied az a group.
Scheme
Facton Settings ﬂ Save bz Delete
kM agnified Area Description: IInmagnified Area D ezcription:
Mouse: Mouse:
kougzeCalar=C0riginal b ouzeColor=Criginal
kMouze Size=5tandard Maouze Size=Standard
Tranzparency=0% Tranzparency=0%
Enhancement: Enhancement:
Enhancement=5hort Crogzhair Enhancement=Short Crozzhair
Color=Light Blue Color=Light Blue
Dizplay=Mouze Maving Digplap=Always
Tranzparency=0% Tranzparency=01%
Thickhezz=h Thicknesz=E
Length=45 Length=75
Height=45 Height=75
Bestore Factory Schemes v Automatically Apply 5 chemes
Cancel | Apply |

The currently selected scheme is displayed in the Scheme list. To switch
to a different scheme, choose a new scheme from the list and then click
Apply or press ALT+A. If you select the Automatically Apply Schemes
check box, MAGic applies the new enhancement settings as soon as you
select a scheme.

Tip: You can also select a scheme directly from the Quick Access
Window. To do this, right-click the Mouse Enhancements,
Cursor Enhancements, or Color Enhancements button and
then choose a scheme from the context menu.

The Magnified Area Description and Unmagnified Area Description boxes
show the current enhancement settings for the magnified area and the
unmagnified area.

Creating New Schemes

To create a new scheme, do the following:

1.  Use the Magnified Area and Unmagnified Area tabs to define
enhancement settings for the magnified and unmagnified areas.
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2. On the Mouse Schemes tab, click Save As or press ALT+S to
create a new scheme based on your current settings.

3. Enter a name for the scheme and then press ENTER. The new
scheme appears in the Scheme list.

Modifying Schemes

To modify an existing scheme, do the following:
1.  Select the scheme you want to modify in the Scheme list.

2. Change the enhancement settings for the magnified and
unmagnified areas.

3. Onthe Mouse Schemes tab, click Save As or press ALT+S.

The name of the currently selected scheme displays in the Save
Scheme dialog box. Press ENTER to save your modifications.

Deleting Schemes

To delete a scheme, do the following:
1.  Select the scheme you want to delete in the Scheme list.

2.  Click Delete or press ALT+D to delete the currently selected
scheme.

Restoring Factory Schemes

Click Restore Factory Schemes or press ALT+R to revert to the original
Factory Settings scheme included with MAGic. Schemes that you or
other users have created remain unchanged.

Cursor Enhancements

From the Magnification menu, choose Cursor Enhancements to
customize the appearance of your cursor in the magnified and

unmagnified areas of the screen. Cursor enhancements make the cursor

easier to follow when editing or writing text. The Magnified Area and
Unmagnified Area tabs provide the same enhancement options.

Note: Cursor enhancements are not available in Windows 95, 98, or
ME.
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The Cursor Schemes tab lets you save your cursor enhancements
settings as a scheme or switch to a different scheme. For more
information on schemes, refer to Using Schemes on page 53.

Select the Enable Cursor Enhancements check box on any tab in this
dialog box to apply enhancements to your cursor. Clear this check box to
disable the cursor enhancements. You can also use the Cursor
Enhancements button to enable or disable cursor enhancements.

Cursor Enhancements

tagnified Area l Unmagnified Area ] Curzor Schermes

[+ Enable Curzor Enhancement Sample Curzor Enhancement

Cursor Attributes

Color: |- Fed j Freedom Scientific

Define Cugtamn Calor.... ”

Curzar Enhancement Attributes

Style: |I:Ival ﬂ Transparency:
Thickness:
Calar; ||:|Deep5kyEluej - Fo000000000000¢
Defineg Cugtorm Color.... ” Length: J

Dizplay: |Eursu:urNu:utMu:uving ﬂ Height; l_

Cancel | Apply |

Cursor Attributes

In the Color list, choose a new color for the flashing cursor that appears
when you are typing text into an edit box, document, and so on. To use
the original system color for the cursor, choose Original. To choose from
additional colors, activate the Define Custom Color button and choose
one of the available colors from the palette.
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Sample Cursor Enhancement

This area allows you to preview your cursor enhancement settings.
MAGic displays a sample of you current cursor enhancements using the
text in this area. This lets you adjust the enhancements to achieve the
desired effect before applying them.

Cursor Enhancement Attributes

The Cursor Enhancement Attributes area allows you to choose a cursor
enhancement style. You can also adjust the appearance and size of the
enhancement and when it displays on your screen.

Style

In the Style list, choose one of the following enhancement styles:

e None - The cursor appears as a blinking vertical bar, with no
additional enhancements.

e Oval - A small area around the cursor is surrounded by an oval.

e Triangle - Two small triangles appear above and below the current
position of the cursor.

e Box - The immediate area around the cursor is surrounded by a
small rectangle.

e Line - Perpendicular lines appear beneath the text and a small
vertical line indicates the exact position of the cursor.
Color

In the Color list, choose a color for the enhancement style you selected.
To invert the brightness or colors of screen areas covered by the
enhancement, choose Invert Brightness or Invert Colors. To choose from
additional colors, activate the Define Custom Color button and choose
one of the available colors from the palette.

Display

In the Display list, choose when MAGic should apply enhancements to
the cursor:

57



e Always - The cursor enhancements are always active and visible
on the screen.

e Cursor Moving - The enhancements are only visible when the
cursor is moving, such as when you are typing text or using the
arrow keys.

e Cursor Not Moving - The enhancements are only visible when the
cursor is stationary.

e When MAGic Key is Pressed - The enhancements only appear
when you press the MAGic Key.

Transparency

Use the Transparency slider to adjust the transparency level of the
cursor enhancement. This is useful if your cursor enhancement
frequently obscures the surrounding text. Higher levels of transparency
allow you to see text and images beneath the enhancement.

Thickness

Use the Thickness slider to adjust the thickness of the cursor
enhancement. Thicker cursor enhancements are easier to see and stand
out more. Thinner cursor enhancements are more subdued and let you
see more of the text.

Length

Use the Length slider to adjust the horizontal size of the cursor
enhancement style. This affects how much text is included within the
oval, box, and line enhancements.

Height

Use the Height slider to adjust the vertical size of the cursor
enhancement style. This affects the height of the oval and box
enhancements and increases the length of the vertical portion of the
line enhancement.
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Color Enhancements

From the Maghnification menu, choose Color Enhancements to define
how MAGic displays colors on your screen. This feature allows you to
replace and swap colors, adjust the brightness and contrast, apply
tinting, make your screen black-and-white (monochrome), and invert
the brightness and colors of your display. You can apply color
enhancements to the magnified area, unmagnified area, or both. The
Magnified Area and Unmagnified Area tabs provide the same
enhancement options.

Note: If you are using Windows 95, 98, or ME, you can only use the
Color Enhancements command to invert the colors of your
screen.

The Color Schemes tab lets you save your color enhancements settings
as a scheme or switch to a different scheme. For more information on
schemes, refer to Using Schemes on page 53.

Select the Enable Color Enhancements check box on any tab in this
dialog box to apply color enhancements to your display. Clear this check
box to disable the color enhancements. You can also use the Color
Enhancements button to enable or disable color enhancements.
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Color Enhancements

Magnified Area | Unmagnified &rea | Color Schemes ]
b onochrome and Tint

[+ Enable Colar Enhancernents i
[ Enable Monochrome and Tint

[ lrevert Brightness
Color:
v |nvert Colors Sl “:l gl v

Drefine Custarn Calor... |

[ Irwert Black and White

Restore System Calars Level =—— J—

Blend: )I
. : Color Switching
Brightness: -
S ;\_J [v Enable Color Switching Add Rule |
* Replace Color = = |
" Swap Colors e
Color: &ictive Color Switches:
- - | | ek v [Elack=Blue
Lrast: - Froe]
ortras Ex With Color: White=1"gllow
|- Blue j
Caticel | Apply

Invert Brightness

Select this check box if you want MAGic to invert the brightness of
colors on your display. Dark colors will appear lighter, while light colors
will appear darker. For example, if you select this check box, black text
becomes white text and dark blue becomes light blue.

Invert Colors

Select this check box to reverse the colors that are displayed on your
screen.

Invert Black and White

If you select this check box, MAGic replaces the color black with white
and the color white with black.

Restore System Colors Button

Click Restore System Colors or press ALT+Y to revert to your default
Windows color settings.
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Brightness

Use the Brightness slider to adjust the brightness of your screen.
Brightness determines how light or dark colors appear. Move the slider
down to reduce the brightness, move it up to increase the brightness.

Contrast

Use the Contrast slider to adjust the contrast of you screen. Contrast
determines the difference between lighter and darker areas. Move the
slider down to reduce the contrast, move it up to increase the contrast.

Monochrome and Tint

The Monochrome and Tint area allows you to tint your screen with a
color or make the screen monochrome (black-and-white). MAGic only
applies these settings if you select the Enable Monochrome and Tint
check box.

Color

In the Color list, choose the color you want MAGic to use to tint your
screen. Choose Grayscale if you want your screen to appear monochrome
(black-and-white). To choose from additional colors, activate the Define
Custom Color button and choose one of the available colors from the
palette.

Level

Use the Level slider to adjust the luminescence, or brightness, of the
tinting. Move the slider to the left to make the color appear darker,
move it to the right to make the color appear brighter.

Blend

Use the Blend slider to control the intensity of the tinting. Move the
slider to the left for strong tinting. At stronger levels, the tinting affects
the color of almost everything on the screen. Move the slider to the
right for a lower level of tinting. At the lowest levels, the tinting only
slightly alters the colors on your screen.
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Color Switching

The Color Switching area allows you to define rules that switch certain
colors on your screen with colors of your choice. MAGic only applies
these color switching rules if you select the Enable Color Switching
check box.

To create a new rule:

1.  Select the Replace Color radio button if you want to use one color
instead of another. Select the Swap Colors radio if you want to
switch two colors on your screen. For example, if you select
Replace Color and choose to replace red with blue, all red objects
will appear blue instead. If you select Swap Colors and choose to
swap red and blue, all red objects appear blue, and all blue objects
appear red.

2. Select one color in the Color list and a second color in the With
Color list. If you are creating a color replacement rule, MAGic will
replace the first color with the second color. If you are creating a
color swapping rule, MAGic will switch these two colors on your
screen.

3.  Click Add Rule or press ALT+D to define your new rule and add it
to the list.

Follow the steps above to add more rules as necessary. To delete a rule,
select it in the Active Color Switches list and click Remove Rule or press
ALT+M.

View Properties

From the Maghnification menu, choose View Properties to customize how
the Split, Lens, Overlay, or Dynamic Lens views appear on your screen.

Split View

The Split tab allows you to define properties for the Split view. Split
view allows you to see both an unmagnified area and a magnified area
at the same time. The Split view opens a magnified window in part of
your screen, but leaves the other part unmagnified as a reference.

62



View Properties

Split lLens ] Overlay ] Dyrnamic Lens
Border
Calar: |- Dark red j
Thickness: s s 9
Position Size
" Battamn " Quarker
[ Top i+ Half
" Right " Custom
" Left
Cancel | Apply |

Color

Select a color for the border that separates the two parts of the split
screen.

Thickness

Move the slider bar to increase or decrease the thickness of the divider
that separates the two parts of the split screen. The bars above the
slider indicate the widths you can select.

Position
Select where you want the magnified area to appear on the screen.
Size

Select how much of the screen you want the magnified area occupy. For
example, if you select Quarter, the magnified area occupies 25% of the
available screen area.

63



Lens

The Lens tab allows you to define properties for the Lens view. Lens
view opens a small rectangular window, which is magnified, while
leaving the remaining desktop unmagnified. The lens moves around the
screen as you move your mouse or when the focus changes.

View Properties

Split Lens lEIverIa_l,l ] Dyrnamic Lens
Border

Color: ([l Black =

|l 1 1 N
T hickness: —J— 10

Cancel | Apply |

Color
Select a color for the border of your lens.
Thickness

Move the slider bar to increase or decrease the thickness of the lens
border. The bars above the slider indicate the widths you can select.

Overlay

The Overlay tab allows you to define properties for the Overlay view.
Overlay view creates a magnified window in the corner of the screen,
while the rest of the screen remains unmagnified. This is similar to the
Lens view, but the Overlay view does not move around the screen.
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View Properties

Split ] Lens  Owerlay lDynamic Lenz
Border

Colr: ([l Black =

1 B N
T hickness: —J— 10

Color
Select a color for the border of your overlay.
Thickness

Move the slider bar to increase or decrease the thickness of the border.
The bars above the slider indicate the widths you can select.

Dynamic Lens

The Dynamic Lens tab allows you to define properties for the Dynamic
Lens view. Dynamic Lens view opens a small rectangular window, which
is magnified, while leaving the rest of the screen unmagnified. This
window follows the mouse pointer or your current location within a
document or dialog box if you are using the keyboard. In addition, when
you move to a dialog box option or menu command, MAGic
automatically resizes the lens so that it only magnifies the currently
selected item. If you type in an edit box or document window, the lens
expands to the width of the entire screen so you can see as much of the
text as possible.
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View Properties

S plit ]Lens ]Dverla_l,l Dynarmic Lers
Border

Colar: |- Black j

Thickness: —J— 10

Color
Select a color for the border of your lens.

Thickness

Move the slider bar to increase or decrease the thickness of the lens
border. The bars above the slider indicate the widths you can select.

Quick View Frame

The Quick View Frame feature allows you to specify regions of the
screen (called frames) that you can monitor while you work in other
areas. MAGic can display one of these frames in the magnified area so
you can see any changes or updates to that part of the screen. To
choose which frame you want to display, or to customize the frame's
position, border color, and color enhancements, open the Magnification
menu and choose Quick View Frame.

Note: The Quick View Frame is only visible while you are using the
Full view and have magnification enabled. In addition, the
Quick View Frame is not available in Windows 95, 98, or ME.
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Properties

The Properties tab allows you to select or modify the active frame and
change the frame’s position and border color.

Quick View Frames

Froperties ] Colar ]

Iv Enable Quick Yiew Frame

Bctive Erame : | Framel ﬂ

Barder Calar: | B Furl= j

Frame Pozition: |T|:u|:| Right ﬂ

Modify Active Frame |

Cancel | |

Enable Quick View Frame

Select the Enable Quick View Frame check box to display the active
frame on your screen in the location specified in the Frame Position list.
Clear this check box to hide the Quick View Frame.

Tip: You can also press MAGic Key+Q to turn the Quick View
Frame on or off.

Active Frame

In the Active Frame list, choose the frame that you want MAGic to
display. You can create and save any number of frames and then choose
the frame the best suits your current needs. To create a frame, do the
following:
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Move the mouse pointer to the top left corner of the region you
want to enclose within the frame and press MAGIC Key+LEFT
BRACKET.

Move the mouse pointer to the bottom right corner of the region
and press MAGic Key+RIGHT BRACKET.

Tip:

To quickly create a frame that is automatically sized to fit a
dialog box option, move your pointer to the option and press
MAGic Key+LEFT BRACKET twice quickly.

Type a name for this frame, then click OK or press ENTER. This is
the name that will appear in the Active Frame list.

Ensure that the frame is positioned over the area of the screen
that you want to monitor. You can move the frame to another
location by dragging the frame’s title bar.

If you want to resize the frame, move your pointer over a corner or
edge of the frame border. When the pointer changes to a double-
headed arrow, drag the border in the desired direction.

When you have finished resizing and positioning the frame, click
Close on the Quick View Manager toolbar (located in the top left
corner of the screen) or press ESC. Choose Yes when MAGic asks if
you want to save your changes.

Tip:

You can press MAGic Key+9 to open the Quick View Manager
and view/modify any frames you have saved.

Border Color

Choose a color for the border of the active frame from the Border Color

list.

Frame Position

Use the Frame Position list to determine where you want the active
frame to appear on your screen.
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Modify Active Frame Button

Click Modify Active Frame or press ALT+M to resize or move the frame
you selected in the Active Frame list. Drag the frame’s title bar to move
it to another part of the screen. To resize the frame, move your pointer
over a corner or edge of the frame border. When the pointer changes to
a double-headed arrow, drag the border in the desired direction.

Color

The Color tab lets you apply color enhancements to the active frame.
You can adjust the brightness and contrast, create color switching rules,
apply tinting, and more. The options available on this tab are identical
to those in the Color Enhancements dialog box. For more information on
these options, refer to Color Enhancements on page 59.

Locator

From the Maghnification menu, choose Locator to select a style and
border color for the Locator. To enable or disable the Locator, use the
Locator button on the MAGic user-interface.

When you activate the Locator, the full screen is temporarily presented
unmagnified. Move the Locator around using the mouse or the arrow
keys, and use the Locator to find something on your screen. Use PAGE
UP to move to the top of the screen, PAGE DOWN to go to the bottom,
HOME to go to the beginning of a line, and END to go to the end of a
line. After you have located the item, press ENTER or the left mouse
button to move the magnified area to that portion of the screen.
Alternatively, you can press ESC to exit the Locator without moving the
magnified area.
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Style
* Full Cross
" Eveqlass

" Bewverse Epeglass

Border
/Il Black =

Cancel

Style

Choose from three different styles for your locator:

e Full Cross — Shows a portion of the screen in reversed colors. In 3%
magnification or higher, the Locator appears with crosshairs
running through the center of the block. With magnification set to
2%, the Locator appears as a block of inversed colors.

e Eyeglass — Shows a square on the screen that is magnified while
the rest of the screen is normal size.

e Reverse Eyeglass — Shows a square on the screen that is
maghnified while the rest of the screen is normal size. Colors within
the magnified square are reversed.

Color

Specify what color border you want to appear around your Locator. The
customizable border only applies to the Eyeglass and the Reverse
Eyeglass options.
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Panning

Panning moves your display either horizontally or vertically, so you can
browse the screen, locate objects, and read magnified text easier. With
magnification set at 2x or higher, you can pan automatically or
incrementally. The advantage of automatic panning is that you can
review the contents of the screen without using repetitive mouse
movements. While incremental panning is similar to automatic panning,
it is different in that your viewing area moves in small, fixed increments
making it easier for you to explore your focal area.

Automatic Panning

Begin automatic panning in any direction by pressing the MAGic Key in
conjunction with any arrow key. Panning then begins in that direction,
and continues until you stop it, or until it reaches the edge of the
screen.

Note: If you disable Line Wrap in the Panning dialog box, then
panning will stop at the right edge of the screen when
panning from left to right.

Stop Panning

To stop panning, press the MAGic Key or the ESC key. You can also use
the arrow key that corresponds with the direction in which you are
currently panning.

Change Panning Direction

Press the arrow key of the direction in which you want to pan.

Panning Quick Advance

Pressing ENTER while panning right scrolls the view to the beginning of
the next line, pauses, and then continues panning to the right.
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Panning Speed

Adjust panning speed during panning, or through the Panning dialog
box. While panning, press NUM PAD PLUS to speed up, and NUM PAD
MINUS to slow down. The speed adjustment only applies to the current
direction of Panning.

Panning Dialog Box

From the Magnification menu, choose Panning to specify panning
properties.

Panning

Fonward Speed: 4 3:
Beverse Speed: 4 El:
Wertical Speed: 43:

v Line 'whap

Point Size: | 1 DEl:

Line Drelay: 'IDEl: [Tenths of & second)

Canicel

Speed

Panning speed is set independently for each panning direction: forward,
reverse, or vertically. Panning speed values are between 1 and 50. You
might want to select different speeds for different directions. As you
read, you are panning forward, which might require a higher panning
speed, than reverse. As you move in the reverse direction you are
probably looking for something, so you would want to go slower. You
may also want to set vertical panning a bit faster, because you will use
vertical panning for skimming documents or Web sites.

Line Wrap

Select Line Wrap if you want MAGic to automatically wrap to the next
line when you reach the right edge of the screen while panning. The edit
spin boxes, below the Line Wrap check box, allow you to control the Line
Wrap settings.
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Point Size

You can adjust the vertical distance that MAGic travels between
successive lines with the line wraps. Point size should correspond to
your font size. The default setting is 10 points.

Note: The point size specified here also controls the size of the
Split View when set to Line.

Line Delay

Line Delay controls the length of the delay while panning between lines.
The Line Delay settings are in tenths of a second. The default setting is
10 (or one second).

Incremental Panning

Before you can use the Incremental Panning feature you must assign
hot keys for each incremental direction. To do this, go to the Keyboard
menu and select Keyboard Assignments. From the Category list, select
Navigation. Next, select the incremental direction you want to assign a
hot key to and then choose the Assign Hot Key button. Within the
Assign Hot Key dialog box type the keystroke you want to use, and then
press ENTER.

When you are done assigning hot keys, choose the OK button to exit the
Keyboard Assignments dialog box.

Tracking

Tracking allows MAGic to follow your activity on the screen. For
example, MAGic can track your mouse pointer so that it always remains
in the center of the magnified area. To change how MAGic tracks the
cursor and mouse pointer, as well as menus, dialog boxes, and
highlighted text, open the Magnification menu and choose Tracking.

73



Tracking

Mouse Dialogs and Menus
(+ Edge (+ Edge
" Center " Center
Curzor Document Beading
" Cerber f Center

M avigation Options
[v Auta Switch [ Mouze Line Lock
W Tether to Dizplay v Track Carets and Cursors

Carnicel

Mouse
To control how MAGic tracks your mouse pointer, select one of the
following radio buttons:

o Edge - If you select this option, MAGic follows your mouse pointer
only when it reaches the edge of the magnified area.

e Centered - If you select this option, MAGic continuously follows
your mouse pointer, ensuring that it is always in the center of the
magnified area.

Cursor
To control how MAGic tracks the cursor when you are typing text, select
one of the following radio buttons:

o Edge - If you select this option, MAGic follows your cursor only
when it reaches the edge of the magnified area.

e Centered - If you select this option, MAGic continuously follows
your cursor, ensuring that it is always in the center of the
maghnified area.

Dialogs and Menus

The Dialogs and Menus area lets you control how MAGic follows your
movement through dialog boxes and menus. Select one of the following
radio buttons:
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e Edge — MAGic automatically moves the magnified area when you
reach the edge of the screen while moving through dialog boxes
and menus.

e Centered — MAGic continuously tracks the active dialog box option
or menu command, ensuring that it is always in the center of the
magnified area.

Document Reading

To control how MAGic tracks highlighted text during document reading,
select one of the following radio buttons:

e Edge — MAGic automatically moves the magnified area when the
highlight reaches the edge of the screen.

e Centered — MAGic continuously tracks the highlight, ensuring that
highlighted text always remains in the center of the magnified
area.

Auto Switch

If you select this check box, centered and relative mouse tracking is
temporarily stopped after you stop moving the mouse. The screen
remains stationary as long as you keep the mouse pointer within the
boundary of the screen. When you move beyond the edge of the screen,
tracking starts again.

Tether to Display

If you select this check box, the mouse pointer is "tethered,"” or
attached, to the magnified display. As soon as you move the mouse, the
mouse pointer automatically appears at the current magnified location,
even if it was not visible on the screen. If you do not select this check
box, MAGic moves to the current location of the mouse pointer when
you move the mouse.

Tip: You can press CTRL+INSERT+NUM PAD MINUS to enable or
disable this option at any time.
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Mouse Line Lock

If you select this check box, you can only move the mouse pointer in
horizontal and vertical directions. If you move the mouse in a diagonal
direction, MAGic moves the mouse pointer in the closest direction.

Track Carets and Cursors

Select this check box if you want MAGic to track your cursor and mouse
pointer.
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Chapter 5
Speech

MAGic Speaks

Not only does MAGic magnify your computer’s screen, but it also has
screen reading capabilities. You can customize MAGic’'s speech
components to fit your needs. The Speech menu, located on the menu
bar contains all the controls to help you adapt MAGic’s speech to suit

you.

v Enable Speech
Global Yoice Adjustment. ..
Individual Yoice Adjustment. ..
Mouse Echo. ..
Tvping Echa...
Verbosity, .,
Yerbosity Scheme. ..
Document and Text Reading. ..

The first item on the Speech menu, Enable Speech, lets you activate or
deactivate speech. If the menu item appears with a checkmark next to
it, speech is enabled. If there is no checkmark, speech is disabled.

The Speech Menu
Global Voice Adjustment

From the Speech menu, choose Global Voice Adjustment to change
MAGic's voice, speech rate, pitch, synthesizer, language, punctuation
level, and other speech options. These speech preferences are used any
time MAGic speaks. If you only want to change certain aspects of
MAGic's speech (such as the speech used to read documents) use the
Individual Voice Adjustment command on the Speech menu. You can
save your speech settings as a voice profile, allowing you to switch
between different settings quickly and easily.
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Tip: You can quickly switch between voice profiles by using the
MAGic Context Menu. Select Voice Profiles from the menu
and then choose the profile you want to use.

Global Yoices
Profile
Mame: |F‘rimary - [default) j
Syrthesizer
Mame: |Elnquence Software j Detect SAPI Synthesizers...

Language: |American Englizh j

“oice

Rate: 57 —J— SalLrme: | Zet thiz using system volume control.
Punctustion: |Sn:nme - Spell Rate Change Percert: | 30

Perzon: | J Upper Case Pitch Change Percent: | 20
Pitch: 65 Jl
o Goncel | savess.. | Restore To Factory |

Save changes and close dialog,

Profile

You can save your global voice settings as part of a voice profile. Use
the Profile area to select and manage voice profiles that you have

created. To save your current voice settings as a voice profile, choose
the Save As button. Profiles can have both global and individual voice

settings.

Tip: You can quickly switch to any of the voice profiles you have
created by pressing MAGic Key+F11. A context menu
displays, allowing you to choose one of the available profiles.

Name

In the Name list, select the voice profile that you want to use.
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Delete

Choose the Delete button to delete the currently selected voice profile.

Synthesizer

The Synthesizer area allows you to select a different speech synthesizer
and synthesizer language.

Name

By default MAGic uses Eloquence as its speech synthesizer, although if
you have other Speech Application Interface (SAPI) synthesizers
installed on your computer, you can use one of those synthesizers
instead. Initially, the list of synthesizers only includes Eloquence. To
add synthesizers, choose the Detect SAPI Synthesizers button.

Note: When you use a synthesizer other than Eloquence, you may
experience a delay of several seconds as you load the other
synthesizer.

Detect SAPI Synthesizers

Choose the Detect SAPI Synthesizers button to find the other
compatible synthesizers installed on your system. After MAGic locates
all compatible synthesizers, the Update Synthesizer List dialog box
appears. On the left side of the dialog box, there is a list of the
available SAPI synthesizers. The buttons in this dialog box allow you to
add or remove synthesizers.

Update Synthesizer List

Cancel

Axallable SA4P1 Synthesizers: Synthesizer List for MAGIc

Lernout and Hauzpie SAP 5 Add All -
Microzoft SAP1 5

add -

<- Hemove

<- Remove All

Il
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To add a new synthesizer:

1.  Select one or more synthesizers from the Available SAPI
Synthesizer list.

2. Choose the Add button to add just the selected synthesizers to the
Synthesizer List for MAGic, or choose Add All to move all
synthesizers to the Synthesizer List for MAGic.

To remove a synthesizer from the Synthesizer List for MAGic:

1.  Select one or more synthesizers from the Synthesizer List for
MAGic.

2. Choose the Remove button to remove only the selected
synthesizers, or choose Remove All to remove all the synthesizers
from the Synthesizer List for MAGic.

Note: Although Eloquence does not appear in the Update
Synthesizer List dialog box, it always appears in the list of
available synthesizers.

Language

In the Language list, select the synthesizer language that you want to
use. The languages that are available are determined by the speech
synthesizer you are using.

Voice

The Voice area allows you to change various characteristics of MAGic's
synthesized speech.

Person

The Person list allows you to select which synthesizer voice you want to
use. The voices that are available are determined by which speech
synthesizer you have selected.
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Rate

The Rate slider allows you to adjust the rate of speech for the currently
selected synthesizer. As you use MAGic, you may want to hear different
types of activities at different rates. For instance, while you are typing,
you may want MAGic to read more quickly, so that you can ensure the
accuracy of your typing. On the other hand, if you are reading a
document, you might want MAGic to speak more slowly, so you can
concentrate on content.

Pitch

The Pitch slider allows you to adjust the pitch for the currently selected
voice.

Punctuation

The Punctuation list allows you to specify how much punctuation MAGic
speaks. Available options are "None," "Some," "Most," and "All."

Volume

If you are using a hardware speech synthesizer, you can use the Volume
slider to increase or decrease the volume of MAGic's speech.

Spell Rate Change Percent

When you hold down INSERT and press NUM PAD 5 twice quickly to
spell a word, the word is spelled at a rate of speech slower than the
normal speech rate. The value in the Spell Rate Change Percent edit box
determines the extent to which the speech rate decreases.

Upper Case Pitch Change Percent

MAGic indicates that a letter is capitalized by reading it with higher-
pitched speech. The value in the Upper Case Pitch Change Percent edit
box determines the extent to which the pitch increases beyond the
normal level. The values and ranges for this setting vary depending
upon which synthesizer is selected.
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Save As

Choose the Save As button to save your current global voice settings as
part of a voice profile. Type a name for your voice profile or select an
existing profile from the list. If you select an existing profile, that
profile's global voice settings will be overwritten by the new settings
when you choose OK.

Restore to Factory

The Restore to Factory button allows you to return to MAGic's default
global voice settings. These were the settings in use when you first
installed the program.

Individual Voice Adjustment

From the Speech menu, choose Individual Voice Adjustment to make
changes to the voices that MAGic uses for reading documents,
messages, menus, dialog boxes, items that you point to with the
mouse, and keystrokes. You can define different settings for each of
these contexts. Like global voice settings, you can save your individual
voice settings as part of a voice profile, allowing you to switch between
different settings quickly and easily.
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Individual Yoices

Prafile

Mlame: |F‘rimary - [defaut) j

Syrthesizer
Pame: |Elnquence Software ﬂ Detect SAPI Synthesizers..

Language: |American Englizh j

“oice

Context: |D-:u:ument Feading Yoice ﬂ Perzon: |Reed ﬂ

Fate: &7 —J— Pitch: B5 Jl

Punctustion:  |Some = “alume: | Set thiz uzing system volume cortral.
................... Q s Cancel | S | Restare To Eactory |

Save changes and close dialog.

The options available in the Individual Voice Adjustment dialog box are
the same as those in the Global Voice Adjustment dialog box. However,
in the Individual Voice Adjustment dialog box, you can define different
voice settings for each context.

Tip: See page 78 for a description of each option in this dialog
box.

Unlike the Global Voice Adjustment dialog box, the Context list allows
you to select which aspects of MAGic's speech you want to change. After
you select one of the following items from the list, use the other
options in the Voice area to customize MAGic's speech for that context:

e Document Reading Voice - Select this option to change the speech
used to read documents.

e Mouse Voice - Select this option to change the speech used for
mouse echo.

o Keyboard Voice - Select this option to change the speech used for
typing echo.

e Message Voice - Select this option to change the speech used for
announcing MAGic messages.
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e Menu and Dialog Voice - Select this option to change the speech
used when navigating menus and dialog boxes.

Mouse Echo

If mouse echo is enabled, MAGic reads text that you point to with the
mouse. To customize this feature, open the Speech menu and choose
Mouse Echo.

Mouse Echo E| [z|

I+ Enable Mousze Echa

Speech Delay: (0.4 _%I [zeconds]

Fuaint & Speal:
{* ‘word Ak Mouze Pozsition

" Line At Mouse Position

I+ Mouse Movement Stops Speech

Caricel |

Enable Mouse Echo

Use this check box to turn mouse echo on or off.

Note: MAGic still speaks ToolTips if mouse echo is off. If you do not
want MAGic to speak ToolTips, open the Speech menu and
choose Verbosity. Then clear the Tool Tips check box.

Speech Delay

Specify the length of time you want MAGic to wait before it reads the
word or line at the current location of the mouse pointer. The delay is
measured in seconds. If you move the mouse pointer away before the
delay has elapsed, MAGic does not read the word or line.

Point & Speak

In this area, select one of the following options:
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e Word at Mouse Position - MAGic reads the word at the current
location of the mouse pointer. You must point at the word for the
length of time specified in the Mouse Speech Delay box before
MAGic reads the word.

e Line at Mouse Position - MAGic reads the line of text at the current
location of the mouse pointer. You must point at the line for the
length of time specified in the Mouse Speech Delay box before
MAGic reads the line.

Mouse Movement Stops Speech

Select this check box to allow MAGic to interrupt speech when you move
the mouse pointer over text. If you clear this check box, you can move
the mouse pointer anywhere on the screen without interrupting speech.
This option does not interrupt speech generated by mouse echo.

Typing Echo

When Typing Echo is enabled, MAGic repeats characters and/or words as
you type them. To customize this feature, open the Speech menu and
choose Typing Echo.

Typing Echo

[ Enable Typing Echo
Twping Echa Lnit
{* Characters
" Words
{" Characters and words

Indizate Capitalization By
" Mo Indication

{* Pitch Increment

" Say"Cap"

|ndicate Capitalization During:

Say Character and Speling j

Carnicel |
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Enable Typing Echo

Select this check box to turn on typing echo. Clear this check box to turn
off typing echo.

Typing Echo Unit
Select one of the following options to determine whether MAGic should
repeat characters you type, words that you type, or both:

e Characters - MAGic speaks each character that you type.

e Words - MAGic speaks each word that you type after you press the
SPACEBAR.

o Characters and Word - MAGic speaks each character that you type
and then reads the entire word after you press the SPACEBAR.

Tip: You can press INSERT+2 at any time to cycle through the
available typing echo units.

Indicate Capitalization
Select one of the following options to determine how you want MAGic to
indicate that a letter is capitalized:

e No Indication - MAGic does not indicate capitalization.

e Pitch Increment - MAGic indicates that a letter is capitalized by
reading it in a higher pitched voice.

e Say "Cap" - MAGic says the word, "Cap," before reading a letter
that is capitalized.

Indicate Capitalization During

If you selected the Pitch Increment radio button, select one of the
following options to determine when MAGic indicates that a letter is
capitalized:

o Say Character and Spelling - MAGic only indicates capital letters
when spelling a word or reading by character.

e Say Word, Character and Spelling - MAGic indicates capital letters
when spelling, reading by word, and reading by character.
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e Say Line, Word, Character and Spelling - MAGic indicates capital
letters when spelling and when reading by line, word, or character.

Tip: You can press MAGic Key+F2 at any time to cycle through the
various options for indicating capitalization.

Verbosity

From the Speech menu, choose Verbosity to control the event driven
functions that MAGic speaks. Select the check boxes of the items that
you want to hear.

Verbosity E| rZ|

Autamatically 5peak
Iv* Control Group Marme W Ikem State

I+ Carntral Narme [ Position | nfarmation
I+ Cantrol Type v Magic Meszage
I+ Dialog Mame v Screen Message
[v Dialog Text v Selected ltem

[v Document Marme [v Statuz lnfarmation
[+ Help Balloon [v Tool Tip

[ Item Humber

bocesz Key

{* Maone

" Speak Al

HRestore Facton Settings |
" Speak Menus Only

" Speak Dialogs Only

Cancel |

Automatically Speak

This area contains check boxes that allow you to determine which items
MAGic reads as you navigate dialog boxes or documents. If the check
box next to the item is selected, then MAGic will announce that item.
The following are brief descriptions of each available verbosity option:

e Control Group Name - Often, options in a dialog box are put into
groups when they have related functions. When this check box is
selected, MAGic speaks the group box heading the first time you
move to or select an item in the group.
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Control Name - MAGic automatically reads the prompts or labels
for dialog box options when you move to them. Control names
appear on the screen, and usually provide information about a
control.

Control Type - MAGic announces the type of the currently selected
dialog box option. There are several common types of controls
found in Windows, including edit boxes, combo boxes, buttons, list
boxes, and so on. Control types do not appear as text on the
screen.

Dialog Name - MAGic reads the text that appears on the title bar
of a dialog box when it becomes active.

Dialog Text - MAGic reads the descriptive, non-interactive text that
appears in dialog boxes.

Document Name - MAGic announces the title of the active
document window. This can be the title of a document in Microsoft
Word, a text document in Notepad, or e-mail message in Outlook.

Help Balloon - Help balloons are used in Windows XP to provide
information about the selected item. When this check box is
selected, MAGic automatically reads this information as it is
displayed.

Item Number - MAGic automatically announces the selected item's
numeric position in relation to the total number of items in a
window, group, or list.

Item State - MAGic announces information that reflects the state
of an item. For example, MAGic will notify you whether a choice in
a list box is selected or not selected.

Position Information - MAGic provides information that describes
an item’s location in relation to the larger structure that contains
it. For example, the coordinates of a table can be considered
positional information because they describe that cell’s position
within the table.



MAGic Messages - MAGic provides you with messages that aid in
navigation by verifying that a Windows action has taken place. For
example, the message, "Top of window," assists in navigation by
alerting you that you have reached the top of the current window.

Screen Message - MAGic reads text that appears on the screen,
but may not be attached to a particular control. For example, some
radio buttons have additional or related information found in
another nearby area of the screen.

Selected Item - MAGic automatically reads the selected item
within a list or window.

Status Information - MAGic provides you with speech feedback
when you perform certain MAGic commands.

Tool Tips — Tool Tips frequently appear when you rest the mouse
over an item for a brief period of time. The Tool Tip gives you a
short description of the item. If this check box is selected, MAGic
speaks Tool Tips of any length.

Access Key Verbosity

Within menus and buttons, often a letter is underlined. You can press
the underlined letter (also called an access key) in conjunction with the
ALT key to activate the command or button. You can choose which
access keys MAGic announces by selecting one of the following options:

None - MAGic does not announce access keys.

Speak All - MAGic announces access keys in both menus and
dialog boxes.

Speak Menus Only - MAGic only announces access keys in menus.

Speak Dialogs Only - MAGic only announces access keys in dialog
boxes.

Restore Factory Settings

Choose the Restore Factory Settings button to return to the default
MAGic verbosity choices. These were the settings in use when you first
installed the program.
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Verbosity Schemes

From the Speech menu, choose Verbosity Schemes to create and switch
between verbosity schemes. Verbosity schemes give you additional
control over which items MAGic announces, as well as how they are
announced. You can also define custom text that MAGic speaks when
you move to a control or other element. Alternatively, you can assign a
sound that you want MAGic to play instead of speaking. You can also
choose to combine both speech and sounds, or tell MAGic to ignore
certain items entirely.

Speech Only - Yerbosity Scheme [g|
Scheme: Speech Orly |
Contral Tepe
Control Topes Behawvior | M
Drefauilt Speak. —
3 State Buttan Speak.
Buttan Speak. ot
Behavior: |Speak ﬂ |
Text: |
Control State
Control States B ehawior 4_\
Drefauilt Speak. —
Checked Speak.
Clozed Speak, et
Behavior: |Speak ﬂ |
Text: |
] | Cancel
Scheme

In the Scheme list, select the verbosity scheme that you want to use. If
you create and save a new scheme, it appears in this list.

Tip: You can press ALT+INSERT+S to select a different verbosity
scheme at any time.
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Save As

After you choose which speech and sounds you want MAGic to use when
announcing various control types and states, choose the Save As button
to save your preferences as a scheme. Navigate to the folder where you
want to save the scheme, and then type a name for the scheme in the
File Name edit box. This is the name that appears in the Scheme list.
Select your new scheme in the Scheme list to activate it.

Delete

Choose the Delete button to delete the verbosity scheme currently
selected in the Scheme list.

Control Type

The Control Type list shows all of the various controls that MAGic can
announce. A control can be a dialog box option, HTML element, heading,
button, or other item. The Behavior column lists the action that MAGic
takes when you move to that control type. "Speak” means that MAGic
announces the control type using synthesized speech. "Play Sound"
means that MAGic plays a specific sound instead of speech. "Speak &
Play Sound" means that MAGic both speaks the control type and plays a
sound. "Ignore"” means that MAGic does not announce the control in any
way.

Behavior

To change the action associated with a control, select the control in the

Control Type list and then choose a new action from the Behavior list. If
you select "Play Sound" or "Speak & Play Sound," you must choose the

Select Wave File button to pick which sound you want to use.

Tip: Assign the behavior "Ignore” to control types that you do not
want MAGic to announce.

Text

If you select "Speak" or "Speak & Play Sound” in the Behavior list, you
can type some custom text in this edit box that you want MAGic to
announce. MAGic reads this text instead of the control type.
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Select Wave File

If you select "Play Sound" or "Speak & Play Sound" in the Behavior list,
choose the Select Wave File button to open the Select Sound dialog box.
Select the sound that you want to use and choose OK. You can choose
the Play button to hear a preview of the selected sound. If the sound
you want to use is not in the list, choose the Browse button to locate the
file on your computer. You can use any sound file with a .wav file
extension. After you locate and select the file, choose OK to add it to
the list of available sounds.

Select Sound [z|
Sound | o
azcend waw

BookClose vway
BuzzerLong waw
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CarDoorClose way
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CarLockOpen way
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Crunch wean
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DeadBotOpen way "
Pley Elru:-wge
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Control State

The Control State list shows all of the control states that MAGic can
announce. Control states provide information about the status of a
control. For example, the control states for a check box are "Checked"
and "Unchecked." The Behavior column lists the action that MAGic takes
when you move to an item with that control state. "Speak" means that
MAGic announces the control state using synthesized speech. "Play
Sound" means that MAGic plays a specific sound instead of speech.
"Speak & Play Sound" means that MAGic both reads the control state
and plays a sound. "Ignore" means that MAGic does not announce the
control state in any way.

Behavior

To change the action associated with a control, select the control in the
Control State list and then choose a new action from the Behavior list. If
you select "Play Sound" or "Speak & Play Sound," you must choose the
Select Wave File button to pick which sound you want to use.

Text

If you select "Speak” or "Speak & Play Sound" in the Behavior list, you
can type some custom text in this edit box that you want MAGic to
announce. MAGic reads this text instead of the control state.

Select Wave File

If you select "Play Sound" or "Speak & Play Sound" in the Behavior list,
choose the Select Wave File button (see page 92) to open the Select
Sound dialog box.

Document and Text Reading

From the Speech menu, choose Document and Text Reading to
customize how MAGic reads, highlights text, and scrolls the page.

Note: You cannot use the box highlight style or adjust the
transparency, thickness, or color of the highlighting if you are
using Windows 95, 98, or ME.
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Highlight Style

When MAGic uses synthesized speech to read the text on your screen, it
can highlight the text it is speaking. This allows you to easily follow the
text visually while MAGic reads. In the Highlight Style list, choose one
of the following options to specify how you want MAGic to highlight text:

e None — MAGic does not highlight text as it reads.

e Box — Surrounds the text MAGic reads with an empty, rectangular
outline.

e Block — Highlights the text MAGic reads with a solid rectangle.
e Underline — Underlines the text that MAGic reads.

Color

In the Color list, choose a color for the highlight style you selected. If
you want to invert the colors in the area covered by the highlight,
choose Invert Colors.

Transparency

Use the Transparency slider to adjust the transparency level of the
selected highlight style. A higher level of transparency allows you to see
more of the surrounding area covered by the highlighting.
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Thickness

Use the Thickness slider to adjust the thickness of the highlight style
you selected. This lets you change the vertical size of the underline and
block highlight styles, and determine the thickness of the border for the
box highlight style.

Auto Scroll During Reading

The Auto Scroll During Reading area lets you customize how speech
advances when the bottom of a window is reached.

e None — Reading stops at the bottom of the window regardless of
the size of the document. The document does not scroll
automatically; you must move to the next screen manually and
make MAGic begin speaking again.

e By Page — Reading continues beyond the window limit by
automatically feeding the next page of the document.

e By Line — Reading continues beyond the window limit by
automatically feeding the document one line at a time.

Move to Last Spoken Word

The following options automatically advance the mouse pointer or
typing cursor when you stop reading:

e Mouse Pointer — If you select this check box, the mouse pointer
automatically moves to the last item that MAGic read when you
stop reading or decide to pause.

e Typing Cursor - If you select this check box, the insertion point
automatically moves to the beginning of the last item that MAGic
read when you stop reading or decide to pause. This feature is only
active when reading documents and windows that you can edit.

Auto Speak Web Pages

Select the Auto Speak Web Pages check box if you want MAGic to
automatically begin reading when you view Web pages or other HTML
documents.
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Chapter 6
Keyboard

The Keyboard menu allows you to customize how you use your
computer’s keyboard with MAGic.

MAGIC Key...
kevboard Assignments. ..

MAGic Key

Pressing the MAGic Key in combination with other keys activates a
MAGic command if one is assigned, otherwise it will pass the key
combination through to the application. Pressing the MAGic Key by itself
and releasing it will not carry out any action.

The default MAGic Key is CAPS LOCK. From the Keyboard menu, choose
MAGic Key to assign the MAGic Key to any of the following keys:
extended INSERT (found on the six pack), NUM PAD INSERT, either
INSERT, or SCROLL LOCK (the key just above HOME on the six pack).

MAGic Key HE]

MAGEIc Key

f+ CapsLock

(" Egtended Inzert
" Wum Pad Inzert
" Either Inzert

" Scroll Lock

Cancel
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Keyboard Assignments

From the Keyboard menu on the MAGic user interface, select Keyboard
Assignments to learn more about the hot keys in MAGic. You can view
the current hot keys assigned to actions, assign different hot keys,
remove hot keys, or restore the hot keys to the default settings from
within the Keyboard Assignments dialog box.

Keyboard Assignments
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SwitchB etweentd agich/isws [~ Left/Right Chl

Toagalekd agnificati -

pagEragniieatn [~ Left/Right Shit

[ Left/Right Al

Deszcription:

Decreazes the magnification one lewvel.

MaGic Fey:Capslock Cancel | Apply |

In the Category list, select what kind of hot keys you want to view. By

choosing one of these categories, the items in the Action list will change

to show only items that fit the category, making the list more
manageable.

Note: Selecting a specific application category shows hot keys for
special MAGic functions in that application. Selecting All
Default will not show application hot keys.

Move to the Action list and select the action that you want to view. The

hot key appears in the Current Hot Keys list, located to the right. If no
hot key appears in the Current Hot Keys list, no hot key is assigned.



Customizing Hot Keys

To add a hot key, select an action in the Action list and click Assign Hot
Key or press ALT+S. Press the combination of keys that you want to
assign to the selected action. The key combination appears in the
Assign To edit box.

When you assign hot keys to actions, it doesn’t matter whether you
press the right or left ALT, CTRL, or SHIFT key. However, you may want
to use only the left or right key so that additional key combinations
remain available. To specify the left or right ALT, CTRL, or SHIFT keys for
a hot key, select the appropriate check box(es) in the Differentiate
Between area before you activate the Assign Hot Key button. For
example, if you want to create a hot key that uses only the left ALT key,
select the Left/Right Alt check box.

Note: The hot keys that you assign while these check boxes are
selected will always require you to press the correct left or
right key. If you later clear the check box, previously created
hot keys still require you to use the correct left or right key.

To remove a hot key, select it in the Current Hot Keys list and click
Remove Hot Key or press ALT+R. MAGic then asks you to confirm that
you want to delete the hot key.

You can click Restore Defaults or press ALT+D to return all hot key
assignments to their original key combinations.
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Chapter 7
Application Specific Functions

MAGic contains application specific functions to help you work in
popular software applications. With MAGic’s application specific
functions, you will find that using these functions consolidates screen
information, enhances application navigation, and eliminates visual
clutter.

For example, with MAGic running in Microsoft® Excel you can bring up a
dialog box that will list the cells for a particular row that contain data.
This consolidates screen information, because it presents the header, if
one exists, and only those cells containing data. You can then move
directly to a particular cell, without pressing the arrow keys to move
through multiple empty cells, which enhances application navigation.
When using MAGic with Microsoft® Internet Explorer, you can eliminate
visual clutter by reformatting the screen. After you reformat, MAGic
presents only the necessary text, and hides graphics that may not be of
interest to you. With only the text showing, you’ll find it easier to read
the less cluttered screen.

Tip: MAGic allows you to save specific groups of settings that are
automatically applied while you use certain programs. For
more information on application-specific settings, see Saving
Your MAGic Settings on page 23.

MAGic and Microsoft Word

This help topic discusses how to use MAGic with Microsoft Word. The
information in this section has been verified for Word 2000 through
2003. The level of support MAGic provides for other versions of this
product may vary.
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MAGic Keystrokes for Word

List Spelling Errors ALT+SHIFT+L
MAGic Key+SHIFT+R or
List Revisions INSERT+SHIFT+R
List Grammatical Errors CTRL+SHIFT+G
CTRL+SHIFT+
List Comments APOSTROPHE
Post Comment ALT+SHIFT+APOSTROPHE
List Hyperlinks MAGic Key+F7 or INSERT+F7
List Inline Objects CTRL+SHIFT+O
MAGic Key+CTRL+HOME or
Focus to First Form Field INSERT+CTRL+HOME
Select a Field MAGic Key+F5 or INSERT+F5
Select a Table MAGic Key+CTRL+T
MAGic Key+ALT+SHIFT+C or
Say Column Title INSERT+ALT+SHIFT+C
MAGic Key+ALT+SHIFT+R or
Say Row Title INSERT+ALT+SHIFT+R
Post Footnote or Endnote ALT+SHIFT+E
Convert Shape to Text ALT+CTRL+SHIFT+C
Read Mistake and Suggestion MAGic Key+F7 or INSERT+F7
Say Current Scheme Name MAGic Key+ALT+Q or
INSERT+ALT+Q
Adjust MAGic Options MAGic Key+0

List Spelling Errors

Press ALT+SHIFT+L to list all the words Microsoft Word marked as
misspelled. From this dialog box, you can move to a selected misspelled
word in the document.
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List Revisions

Press MAGic Key+SHIFT+R or INSERT+SHIFT+R to list all the revisions
in Word’s Track Changes feature. From this dialog box, you can move to
a selected revision in the document.

List Grammatical Errors

Use CTRL+SHIFT+G to list all the phrases marked by Microsoft Word as
grammatical errors. From this dialog box, you can move to a selected
grammatical error in the document.

List Comments

Use CTRL+SHIFT+APOSTROPHE to list all the reviewer’'s comments
throughout the document, and this dialog box allows you to move to the
selected comment.

Post Comment

Press ALT+SHIFT+APOSTROPHE to display a comment in a message
box. To use this keystroke with speech you must enable Unpunctuated
Phrases in the Verbosity dialog box found under the Speech menu and
place the insertion point at the very end of the comment marker in the
document. Use this keystroke to avoid hovering over the comment
marker in the document. If you hover over the comment marker in
higher magnifications, scrolling the magnified comment text could be a
problem.

List Hyperlinks

Press MAGic Key+F7 or INSERT+F7 to list the hyperlinks in the current
document. From this dialog box, you can either move to the hyperlink in
the document, or you can activate the hyperlink.

List Inline Objects

Press CTRL+SHIFT+O to list all inline objects in the text layer of the
document. It allows you to move to the location of the selected object in
the document.
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Focus to First Form Field

Press MAGic Key+CTRL+HOME or INSERT+CTRL+HOME to move to the
first form field in a document.

Select a Field

Use MAGic Key+F5 or INSERT+FS5 to list all the fields in a document.
From this dialog box, you can move to a selected field.

Select a Table

Press MAGic Key+CTRL+T to list all the tables in the document. You can
move to a table from the dialog box that appears. If the document is
protected to only allow edits in form fields, MAGic moves the insertion
point to the first form field of the selected table.

Say Column Title

Press MAGic Key+ALT+SHIFT+C or INSERT+ALT+SHIFT+C while in any
cell of a table column to hear that column's title.

Say Row Title

Press MAGic Key+ALT+SHIFT+R or INSERT+ALT+SHIFT+R while in any
cell of a table row to hear that row's title.

Post Footnote or Endnote

Press ALT+SHIFT+E to display a footnote or endnote in a message box.
The insertion point must be located on the footnote or endnote
reference and you must enable Unpunctuated Phrases in the Verbosity
dialog box found under MAGic’s Speech menu.

Convert Shape to Text

Press ALT+CTRL+SHIFT+C to change unreadable graphics such as
WordArt into text that can be read by MAGic.
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Read Mistake and Suggestion

Press MAGic Key+F7 or INSERT+F7 while in the Spelling and Grammar
dialog box to read and spell the misspelled word and the first suggested
replacement.

Say Current Scheme Name

Press MAGic Key+ALT+Q or INSERT+ALT+Q to hear the name of the
currently loaded scheme for the active document.

MAGic Options for Word

Press MAGic Key+O to display the Adjust MAGic Options dialog box. The
options in this dialog box allow you to control how much information
MAGic provides about the document while you navigate or edit it. Use
the arrow keys to move through the list. To change the currently
selected option, press the SPACEBAR or click the Execute button. When
you are finished, choose the Close button. Each option in the Adjust
MAGic Options dialog box is described below.

Fields

If this option is on, MAGic announces form fields as you navigate the
document.

Announce Cell Coordinates

If this option is on, MAGic announces the coordinates of the current
table cell when you move to it.

Tables

If this option is on, MAGic announces when you move into, out of, and
within a table (from row to row or column to column) and even warns
you when you move into the last cell. MAGic can also detect nested
tables.
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Table Description

Non-uniform tables are tables with rows that span more than one
column, or columns that span more than one row. When this option is
on, MAGic provides detailed information about these tables that can
help you navigate and get oriented. If you do not want to hear this
information, turn this option off. This setting is retained even after you
quit Word.

Override Named Titles

Document authors can use bookmarks to make tables more accessible
by indicating row and/or column headings. This verbosity option allows
you to ignore these named titles. Choose "On for the current file" to
override named titles only for tables in the currently open document.
Choose "On for all files" to override named titles in all documents that
you open in Word. By default, this option is set to "Off" so that MAGic
can process any named titles that an author may have inserted into the
document.

Creating Accessible Tables

You can create accessible tables for MAGic 10.0 or later and JAWS 6.0
or later solely by using functionality available in Microsoft Word. This
means that even those who do not use accessibility software can mark
table row and/or column headings for JAWS and MAGic users.

To make a table accessible for users of JAWS or MAGic, start Microsoft
Word and open the document containing your table(s). If the table has
both row and column headings, place the insertion point in a cell where
the row and column containing the headings meet. Then, open the
Insert menu and choose Bookmark. Type "Title" and press ENTER.

If the table has only row headings, place the insertion point in any cell
within the column containing the headings. Then, open the Insert menu
and choose Bookmark. Type "RowTitle" and press ENTER.

If the table has only column headings, place the insertion point in any
cell within the row containing the headings. Then, open the Insert menu
and choose Bookmark. Type "ColumnTitle" and press ENTER.
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Tip: Do not place a bookmark in each cell that contains a heading.
JAWS recognizes all cells in the marked row and/or column as
a heading.

Microsoft Word does not allow two bookmarks to use the same name. If
there is more than one table in your document, add a number or
descriptive word to the end of the bookmark text used to indicate
headings. For example, "Title_1," "RowTitle_Revenue," or
"ColumnTitle_Expenses."

Any MAGic user can override the information provided by the document
author. To do this, press MAGic Key+0 while you are in Word to open
the Adjust MAGic Options dialog box. Select "Override Named Titles"
and use the SPACEBAR to cycle through the available options. Choose
"On for the current file" to override named titles for tables in the
currently open document. Choose "On for all files" to override named
titles in all documents that you open in Word. If you want to use the
table information provided by the author again, choose "Off."

MAGic and Microsoft Excel

This help topic discusses how to use MAGic with Microsoft Excel. The
information in this section has been verified for Excel 2000 through
2003. The level of support MAGic provides for other versions of this
product may vary.

MAGic Keystrokes for Excel

List Cells with Comments CTRL+SHIFT+APOSTROPHE
Read Cell Comment ALT+SHIFT+APOSTROPHE
List Column CTRL+SHIFT+C
Set Column Titles Range ALT+CTRL+SHIFT+C
Post Column Title ALT+SHIFT+C

CTRL+MAGic Key+ENTER or
Set Totals Column CTRL+INSERT+ENTER
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Post Column Total INSERT+ENTER
List Row CTRL+SHIFT+R
Set Row Titles Range ALT+CTRL+SHIFT+R
Post Row Title ALT+SHIFT+R
CTRL+MAGic Key+DELETE or
Set Totals Row CTRL+INSERT+DELETE
Post Row Total INSERT+R or INSERT+DELETE
List Visible Cells with Data CTRL+SHIFT+D
Select Hyperlink CTRL+SHIFT+H
Read Cell Hyperlink ALT+SHIFT+H

Set Monitor Cells

ALT+CTRL+SHIFT+1 through O

Move to Monitor Cell

CTRL+SHIFT+M

Return to Previous Cell CTRL+SHIFT+GRAVE
Post Monitor Cells ALT+SHIFT+1 through O
Move to Worksheet CTRL+SHIFT+S

Say Active Cell Coordinates INSERT+C

Spell Check INSERT+F7

Collapse Selection to Active Cell | SHIFT+BACKSPACE
Adjust MAGic Options MAGic Key+0

List Cells with Comments

Use CTRL+SHIFT+APOSTROPHE to list all of the cells in the visible
window that have an attached comment. This allows you to quickly
locate any visible cells that may provide important information about

the spreadsheet.

Read Cell Comment

Use ALTH+SHIFT+APOSTROPHE to read a cell comment if there is one.

106




List Column

Use CTRL+SHIFT+C to list the cells in the current column that contain
data. From this dialog box, you can move to a particular cell. If you
defined column or row titles they will also be displayed.

Set Column Titles Range

Use ALT+CTRL+SHIFT+C to define the current row as the row containing
column titles.

Post Column Title

Press ALT+SHIFT+C to speak current column’s title (if speech is
enabled) or display it in a message box (if speech is disabled). Use this
keystroke when you work in complex datasheets to find the column title
without scrolling away from your current place. You must define the
column’s title before the keystroke will be effective. Do so from within
the Adjust MAGic Options dialog box. You also must enable
Unpunctuated Phrases in the Verbosity dialog box if you want speech.
You can find the Verbosity dialog box under MAGic’'s Speech menu.

Tip: If speech is enabled you can press ALT+SHIFT+C twice quickly
to display the column title in a message box.

Set Totals Column

Use CTRL+MAGic Key+ENTER or CTRL+INSERT+ENTER to define the
current column as the column containing row totals.

Post Column Total

Press INSERT+ENTER to display the current column’s total in a message
box. MAGic will find either the predefined row containing column totals,
set in the Adjust MAGic Options dialog box, or will search the current
column for a cell that contains the word SUM. To use this keystroke with
speech you must enable Unpunctuated Phrases in the Verbosity dialog
box found under the Speech menu.
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List Row

Use CTRL+SHIFT+R to list the cells in the current row that contain data.
This allows you to set focus on the selected cell. If you defined column
or row titles they will also be displayed.

Set Row Titles Range

Use ALT+CTRL+SHIFT+R to define the current column as the column
containing row titles.

Post Row Title

Press ALT+SHIFT+R to speak current row’s title (if speech is enabled) or
display it in a message box (if speech is disabled). You must define the
row’s title first, using the Adjust MAGic Options dialog box and you
must enable Unpunctuated Phrases in the Verbosity dialog box found
under the Speech menu.

Tip: If speech is enabled you can press ALT+SHIFT+C twice quickly
to display the row title in a message box.

Set Totals Row

Use CTRL+MAGic Key+DELETE or CTRL+INSERT+DELETE to define the
current row as the row containing column totals.

Post Row Total

Use INSERT+R or INSERT+DELETE to display the current row’s total in a
message box. MAGic will find either the predefined column containing
row totals, set in the Adjust MAGic Options dialog box, or will search the
current row for a cell that contains the word SUM. To use this keystroke
with speech you must enable Unpunctuated Phrases in the Verbosity
dialog box found under the Speech menu.

List Visible Cells with Data

Use CTRL+SHIFT+D to list only the cells with data, which are visible on
the screen. This enables you to quickly access relevant cells that are
visible on the current screen, skipping blank cells.

108



Select Hyperlink

Press CTRL+SHIFT+H to list all hyperlinks on the current sheet, and this
dialog box allows you to either move to the cell containing the
hyperlink, or activate the link.

Read Cell Hyperlink

Press ALT+SHIFT+H to read a hyperlink associated with the selected
cell.

Set Monitor Cells

Use monitor cells to observe an area of your spreadsheet as you work.
Press ALT+CTRL+SHIFT+1 to assign the cell or region of cells to the first
monitor cell. Use ALT+CTRL+SHIFT+1 through O to assign up to ten
different monitor cells.

Move to Monitor Cell

Press CTRL+SHIFT+M to list all defined monitor cells, so you can move
to a particular cell.

Return to Previous Cell

After you move to monitor cell with CTRL+SHIFT+M, you can press
CTRL+SHIFT+GRAVE to return to the previous cell.

Post Monitor Cells

Press ALT+SHIFT+1 through O on the number row to speak the contents
of that monitor cell (if speech is enabled) or display the contents in a
message box (if speech is disabled). For example if you have five
monitor cells defined, and you want to know the information in the third
monitor cell, press ALT+SHIFT+3. To use this keystroke with speech you
must enable Unpunctuated Phrases in the Verbosity dialog box found
under the Speech menu.

Tip: If speech is enabled you can press ALT+SHIFT+1 through O
twice quickly to display the monitor cell contents in a
message box.

109



Move to Worksheet

Press CTRL+SHIFT+S to list the worksheets in the current workbook. You
can then select one from the list and move to the first cell in that
worksheet.

Say Active Cell Coordinates

Use INSERT+C to announce the coordinates of the active cell. Press this
keystroke twice quickly to spell out the coordinates. Press this
keystroke three times quickly to hear the coordinates of the active cell
announced phonetically.

Spell Check

Use INSERT+F7 to read the spelling error and suggested replacement
word using Spell Checker.

Collapse Selection to Active Cell

Use SHIFT+BACKSPACE to minimize the highlighted area of the current
selection down to the active cell.

MAGic Options for Excel

Press MAGic Key+O to adjust options that allow for easier navigation in
higher levels of magnification. MAGic presents the Adjust MAGic
Options dialog box, which contains several options from which you can
choose.

Cell Verbosity

Use this verbosity option to determine whether you want MAGic to
announce a cell's coordinates when you select it.

Formulas

The announcement of formulas can be toggled for each worksheet in a
specific workbook. Formula announcement is on by default.
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Comments

The announcement of comments can be toggled for each worksheet in a
specific workbook. Comment announcement is on by default.

Regions

If you use more than one region in Excel, turn on multiple region
support to hear when you enter different regions. For information
regarding regions, please see the Excel Help file.

Title Reading

You can change how MAGic reads row and column titles you have
defined. Choose one of the following:

e Off - MAGic does not announce row or column titles.

e Read Row Titles - When you move to a different row, MAGic reads
the row title. MAGic does not announce column titles.

e Read Column Titles - When you move to a different column, MAGic
reads the column title. MAGic does not announce row titles.

e Read Both Titles - When you move to a different column, MAGic
reads the column title. When you move to a different row, MAGic
reads the row title.

Read Titles for
Use this option to define how MAGic should read row and column titles.
Set Region Column Titles to Row Range

MAGic defined the selected row range as the rows containing column
titles so that when you press the keystroke to Post Column Title, MAGic
reads the title for the current row.

Set Region Row Titles to Column Range

MAGic define the selected column range as the columns containing row
titles so that when you press the keystroke to Post Row Title, MAGic
reads the title for the current column.
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Set Totals Column

MAGic defines as the column in this region where row totals will be
found. If you press post row total, instead of searching down the row to
find the total, MAGic looks directly to this column.

Set Totals Row

MAGic defines as the row in this region where column totals will be
found. If you press post column total, instead of searching down the
column to find the total, MAGic looks directly to this column.

Define Monitor Cells

A monitor cell is a cell or range of cells you can observe while you work
in other areas of the spreadsheet. You have ten monitor cells available,
which are defined by pressing ALT+CTRL+SHIFT+1 through O on the
number row, and read by pressing ALT+SHIFT+1 through 0. Instead of
using ALT+CTRL+SHIFT+1 through O, you can press MAGic Key+O for
Adjust MAGic Options, and press the SPACEBAR on this option, and
MAGic determines the next undefined monitor cell for this sheet and
defines it to point to the currently selected range of cells. MAGic then
tells you which monitor cell it has assigned to the range. Then you press
the appropriate keystroke to read this range from anywhere on this
sheet. For example, if you hear, "assigning monitor cell 5 to B5," it
means that you should press ALT+SHIFT+5 to hear the cell contents.
Monitor cells are defined on a sheet-by-sheet basis regardless of the
multiple or single region support setting.

Announce Monitor Cell Titles

Use this option to toggle the announcement of titles for monitor cells
that you select.

Clear Monitor Cells

Clears the monitor cells defined for the current sheet.
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Clear Title and Total Definitions

Clears any definitions for the following: the row range used for this
region’s column titles, the column range used for this region’s row
titles, and the row and column used for column and row totals. It also
turns off title reading and resets MAGic so if you press a total reading
keystroke (Post Row/Column total), MAGic will search across the row or
down the column in the current region for a total rather than using the
defined total row or column.

Override Named Titles

Any MAGic user can override row and column title information provided
by the spreadsheet author. To do this, choose "On for the current file" to
override named titles only in the currently open spreadsheet. Choose
"On for all files" to override named titles in all spreadsheets that you
open in Excel. If you want to use the row and column title information
provided by the author again, choose "Off."

Workbook Settings

The Workbook Settings option determines which settings to use to read
a particular workbook. If you often receive workbooks that contain
similar setups, for example, or if you receive a workbook every month
for which you can use the same title, total, and monitor settings, you
would not want to have to set these features for every new workbook. If
you choose "Best Match," MAGic determines which of your settings files
best matches the current workbook, and automatically loads these
settings. If you only want settings to load if they are designed for a
particular workbook, choose "Exact Match."

Defining Row and Column Titles

Before MAGic can read the titles of cells within a spreadsheet, you must
specify which columns and/or rows contain those titles. To define row
titles, move to the column containing the row titles and press
ALT+CTRL+SHIFT+R. To define column titles, move to the row containing
the column titles and press ALT+CTRL+SHIFT+C.
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Tip: You can also press MAGic Key+0 to use the Adjust MAGic
Options dialog box to define row and column titles.

Alternatively, you can use Excel's naming function to specify which rows
and columns contain cell titles. Using names instead of MAGic
commands makes the spreadsheet accessible to any user of MAGic 10.0
or later and JAWS 6.10 or later. There is no need to provide other users
with the spreadsheet's .jsi file because the row and column title
information is saved in the worksheet. This feature allows any
spreadsheet author to define row and column titles without installing or
using JAWS or MAGic.

To use names to define row and column titles, do the following:

1.  Move to the first cell in the column or row containing the titles. If
the spreadsheet contains both row and column titles, move to the
cell where these two intersect.

From the Insert menu, select Name and press RIGHT ARROW.
Select Define and press ENTER.

If the column contains row titles, type "RowTitle" and press
ENTER. If the row contains column titles, type "ColumnTitle" and
press ENTER. If the cell is the intersection of both row and column
titles, type "Title" and press ENTER.

If you are defining column/row titles for any worksheet other than
worksheet 1, you must add the number of the worksheet after
"RowTitle," "ColumnTitle," or "Title." For example, if you are
defining a row containing column titles in worksheet 4, you would
type "ColumnTitle4." To hear which worksheet you are in, press
INSERT+F1.

Tip: You can define more than one row or column as a title range.
For example, if you want to define rows 1 and 2 as column
titles, select both rows and then assign the name
"ColumnTitle" to them.
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MAGic can now recognize the cell as the beginning of a range of row
and/or column titles. If a particular worksheet within a workbook has
title rows and/or columns defined using this feature, you cannot use the
standard MAGic method for defining title rows and/or columns.
However, if another worksheet in the same workbook does not have row
and column titles defined using the Excel naming function, you can use
the standard MAGic method. In addition, you cannot use this feature if
the spreadsheet contains multiple regions.

Defining Row and Column Titles for Worksheets with
Multiple Regions

You can define individual row and/or column titles for different regions
in the same workbook. To define a row and/or column title for region,
you use the same procedure described in Defining Row and Column
Titles on page 113 to assign a specific name to a cell in the heading row
and/or column. However, you must use the following procedure when
defining names for row and column titles that are specific to one region:

1.  Type "TitleRegion," "RowTitleRegion," or "ColumnTitleRegion"
depending on whether this cell is in the heading row, heading
column, or both.

2. Type the region number. For example, you would type a "1" if the
cells were in the first region. There should be no space between
the previous text and this number.

3. Type a period followed by the coordinates of the top, left cell in
the region (for example, "A1").

4. Type a period followed by the coordinates of the bottom, right cell
in the region (for example, "N9").

5. Type a period followed by the worksheet number. For example,
you would type a "1" if the cell was in worksheet 1.
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For example, assume you have a spreadsheet with a region whose
boundaries are row 1 at column A and row 9 at column N. It also has a
second region with boundaries of row 10 at column C and row 14 at
column D. Both regions are on worksheet 1. To define row 1 as the row
containing column headers for the cells in the first region, you would
assign the following name to cell A1: ColumnTitleRegion1.A1.N9.1. To
define row 9 as the row containing column headers for the cells in the
second region, you would assign the following name to cell C10:
ColumnTitleRegion2.C10.D14.1.

MAGic and Microsoft Internet Explorer

MAGic has shortcut keys to help you use Internet Explorer without
relying on the mouse to access certain features. The information in this
section has been verified for Internet Explorer 6 or later. The level of
support MAGic provides for other versions of this product may vary.

MAGic Keystrokes for Internet Explorer

Select a Link MAGic Key+F7 or INSERT+F7
Select a Form Field MAGic Key+F5 or INSERT+F5
Select a Link

Use MAGic Key+F7 or INSERT+F7. Opens a dialog box containing a list
of the links present in the page. You can then select a link by using the
arrow keys or the first letter of the link. Press ENTER to open the
selected link.

Select Form Field

Use INSERT+F5. Displays a list of all form fields on the page. You can
then select a field by using the arrow keys or the first letter of the form
field name. Press ENTER to move to the selected form field.
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Using Forms

MAGic allows you to interact easily with Web-based forms whether you
use the mouse or the keyboard to select form controls. MAGic will also
let you switch easily between navigating the Web page contents and
interacting with the form controls.

When using the mouse, clicking on a form control, such as an edit box
or list, switches MAGic to Forms mode. To exit Forms mode, click
anywhere on the page other than the form controls.

When using the keyboard, move to a form control and press the ENTER
key to switch to Forms mode. To exit Forms mode, press NUM PAD
PLUS.

Tip: Forms mode is automatically turned off when you activate the
button that submits the form.

After you switch to Forms mode, you can then use the arrow keys to
navigate within the list or edit field. In the case of edit fields, you can
also use navigation and selection keystrokes as usual. You cannot
navigate outside the form controls with the arrow keys until you exit
forms mode.

MAGic and Adobe Acrobat/Reader

MAGic has shortcut keys to help you use Adobe Acrobat and Reader
without relying on the mouse to access certain features. The information
in this section has been verified for Adobe Acrobat/Reader 6 or later.
The level of support MAGic provides for other versions of these products

may vary.
MAGic Keystrokes for Adobe Acrobat/Reader
Select a Link MAGic Key+F7 or INSERT+F7
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Select a Link

Use MAGic Key+F7 or INSERT+F7. Displays a list of the links present in
the PDF document. You can then select a link by using the arrow keys or
the first letter of the link. Press ENTER to open the selected link.

MAGic and Outlook/Outlook Express

MAGic has shortcut keys to help you use Outlook and Outlook Express
without relying on the mouse to access certain features. The information
in this section has been verified for Outlook 2000 and later and Outlook
Express 6 or later. The level of support MAGic provides for other
versions of these products may vary.

MAGic Keystrokes for Outlook/Outlook Express

Read M|§spelled Word and INSERT+F7
Suggestion

Read MSAA Information ALT+CTRL+SHIFT+M
Read From and Subject (Outlook | ALT+CTRL+1

2000 only)

Say Date (Outlook 2000 only) MAGic Key+CTRL+D

Read Misspelled Word and Suggestion

Use INSERT+F7. Speaks and spells the misspelled word and the first
suggestion in the Outlook spellchecker.

Read MSAA Information

Use ALT+CTRL+SHIFT+M. If information for the currently selected item
is abbreviated or not read in full, perform this command. MSAA
(Microsoft Active Accessibility) provides more details to MAGic so that
the information can be read completely.

Read From and Subject

Use ALT+CTRL+1. Reads the From and Subject fields in the message
header. This command is only available in Outlook 2000.
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Say Date

Use MAGic Key+CTRL+D. Speaks the currently selected day, month, and
date in the Day view of the calendar. This command is only available in
Outlook 2000.

119



Chapter 8
Contacting Freedom Scientific

Freedom
Scientific’

Corporate Headquarters

Freedom Scientific BLV Group, LLC
11800 31st Court North

St. Petersburg, FL 33716-1805
USA

Telephone: (727) 803-8000
Fax: (727) 803-8001
World Wide Web: http://www.FreedomScientific.com

Office hours: Monday through Friday 8:30 am to 5:00 pm Eastern
Standard Time (USA)

Technical Support Hours: Monday through Friday 8:30 am to 7:00 pm
Eastern Standard Time (USA)

Freedom Scientific Web Site

The Freedom Scientific Web site, http://www.FreedomScientific.com, is a
comprehensive source of information regarding MAGic screen
magnification software, JAWS screen reader software, training
opportunities, application-specific cassette tutorials and the company
that develops these products.
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The Freedom Scientific Web site is designed to be accessible by people
with disabilities and includes a great deal of technical support
information as well as online ordering capability, RealAudio descriptions
of many products, and continuous product update and maintenance
downloads.

Documentation Feedback

At Freedom Scientific, we strive to produce the highest quality
documentation products, and welcome your feedback. If you have
comments or suggestions about our online Help or printed guides, send
your e-mail messages to Documentation@FreedomScientific.com.

Sales
Contacting the Freedom Scientific Sales Department
Sales Telephone: (800) 444-4443
International Sales Telephone, including Canada: (727) 803-8000
Sales Fax: (727) 803-8001
World Wide Web: http://www.FreedomScientific.com

Sales e-mail: info@FreedomScientific.com

To ensure that your request is handled promptly, include your complete
address and telephone number.

Office Hours:  Monday through Friday,
8:30 am to 5:00 pm EST (USA)

Technical Support

You must be a registered user to access Freedom Scientific support
services. Freedom Scientific support services are subject to Freedom
Scientific terms and conditions in place at the time the service is used.

Reach Technical Support using the following options:

World Wide Web: http://www.FreedomScientific.com

121



Technical Support e-mail: Support@FreedomScientific.com
Technical Support Telephone: (727) 803-8600

When you call, be at your computer, have your documentation in hand,
and be prepared to provide the following information:

e Product serial number used for registration.

e Product name and version number.

e Type of computer hardware you are using.

e Software version humber of Windows.

e Exact wording of any messages that appear on your screen.
e What you were doing when the problem occurred.

e How you tried to solve the problem.

Technical Support Hours:  Monday through Friday
8:30 am to 7:00 pm EST (USA)
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Appendix A
Remote Access

Remote access software, like Citrix Program Neighborhood and Remote
Desktop Connection, allows you to establish a connection from your
computer (called the “client”) to another computer (called the
“server”). Once connected, you can run programs and view files just as
if you were sitting at the server’s keyboard. The server handles all
processing and data storage tasks. The client computer acts as an
intermediary between you and the server, relaying your commands and
displaying the results.

Visually, users see a graphical representation of the server’s desktop on
their client computer. However, the version of MAGic installed on the
client cannot read or interact with this image. With MAGic remote
access, you install a version of MAGic on the server to provide access to
programs you use while in a terminal session. The version of MAGic
installed on the server sends the output to the client through a virtual
channel. The version of MAGic installed on the client computer then
relays this output to the user.

The Remote Access feature is only available for licenses of MAGic
Professional that use Internet License Manager (ILM) for authorization.
You cannot use the Quella or thumb drive versions of MAGic in terminal
sessions. The Remote Access feature must be purchased separately.
Contact Freedom Scientific Sales for more information.

System Requirements

Server System Requirements

Citrix and Terminal Services both allow client computers to connect to
the server and access programs and files stored on it through the
Windows user interface. Your server must meet the following
requirements:

e Microsoft Windows 2000/XP or Windows Server 2000/2003.
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e If you are using Citrix ICA protocol, you will need Citrix MetaFrame
Feature Release 3 or later.

Client System Requirements

Client computers can use Remote Desktop Protocol (RDP) or Citrix
Independent Computer Architecture (ICA) protocol to connect to a
server and access its programs and files. MAGic only supports Windows-
based clients.

There are no additional system requirements beyond those required for
MAGic and Citrix Program Neighborhood, Terminal Services Client,
and/or Remote Desktop Connection. In addition, client computers must
meet the following minimum requirements:

e Program Neighborhood Client version 7.0 or later, if you are using
Citrix ICA protocol.

e If you are using Terminal Services, you need either Microsoft
Remote Desktop Connection version 5.0 or later or Terminal
Services Client version 5.0 or later.

e One or more serial ports, if you are using a serial hardware
synthesizer. One port is required for each device.

e One or more USB ports, if you are using a USB hardware
synthesizer. One port is required for each device.

User and Shared Profiles for Remote Access

Just as Windows provides a My Documents folder for each user on a
computer or server, MAGic allows each user to have their own profile.
This profile contains the user's custom settings. This allows different
users on the same system to set up and run MAGic in completely
different ways. MAGic saves your user settings in Documents and
Settings\User Name\Application Data\Freedom

Scientific\MAGic\ VersiomSettings\Enu.
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In addition to these user profiles, MAGic also sets up a shared profile.
MAGic uses the settings in this shared profile whenever the user has not
specifically defined their own custom settings. The shared profile allows
a network administrator to set up a baseline configuration for MAGic
according to the needs of that network's users. MAGic saves shared
settings in Documents and Settings\All Users\Application Data\Freedom
Scientific\MAGic\ VersiomSettings\Enu.

Note: User settings override any identical setting specified in the
shared profile.

User and shared profiles allow MAGic to work better with Citrix
MetaFrame and Terminal Services. Each user that connects remotely to
the server uses his or her own user settings, without overriding the
shared settings or the settings of other users. Your settings for remote
sessions are stored on the server and are available if you connect to the
server using the same account and a different client computer. A user
can have different settings for using MAGic locally on the client
computer and using MAGic remotely with the server.

Assigning Access Privileges

Before installing MAGic on the server, ensure that you have full write
access to the folder where MAGic will be located. All MAGic users should
have read-only access to this folder using the same network name.

MAGic saves user settings files in the folder Documents and
Settings\User Name\Application Data\Freedom

Scientific\MAGic\ Versiom\Settings\Enu (where User Name is the name
associated with the user account). Users must have read and write
access to these files.

Settings in shared files apply to all MAGIC users on the computer or
network. MAGic saves shared files in Documents and Settings\All
Users\Application Data\Freedom Scientific\MAGic\ VersiomSettings\Enu
so they are accessible to each user that logs on to the computer. Users
must have a minimum of read-only access to these files.
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Remote Access Installation Instructions

You must install MAGic on the server and all client computers. The
server and/or client must have the proper licenses with the remote
access option enabled. In addition, the version of MAGic installed on the
server must be identical to the version of MAGic installed on the client
computer.

Installing MAGic on the Server

Do the following to install MAGic with remote access support on the
server. This procedure provides MAGic speech access for local users of
the server. You must have administrative privileges for the server to
install MAGic. In addition, you must restart the server after installation.

Tip: For information on installing MAGic on the server remotely or
without installing the drivers, refer to the MAGic online help
system.

Insert the MAGic program CD into the server’s CD drive.

2. When the MAGic Setup dialog box displays, choose the MAGic
Setup button. If the dialog box does not appear, press WINDOWS
Key+R, type “D:\Setup.exe” and press ENTER (if your CD drive is
not D, substitute the correct letter).

Note: If you are installing MAGic from the package for the Web,
press WINDOWS Key+E, navigate to the folder where you
saved the package file, select the file, and press ENTER.

3. When Setup asks you to select an installation type, select Guided.
Choose the destination folder and your startup preferences.

5. When Setup asks you to select remote access components, select
the Allow MAGic Enabled Clients to Connect to this System check
box. If you intend to use the server computer locally to connect to
another server, you can select the Allow this System to Connect to
MAGic Enabled Servers check box as well.

6. Follow the instructions and complete the installation.
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Installing MAGic on Client Computers

After

you install MAGic on the server, you must install the program on

any client computers that will use MAGic while accessing the server
remotely.

Do the following to install the program on a client computer:

1.
2.

Insert the MAGic program CD into the client computer’s CD drive.

When the MAGic Setup dialog box displays, choose the MAGic
Setup button. If the dialog box does not appear, press WINDOWS
Key+R, type “D:\Setup.exe” and press ENTER (if your CD drive is
not D, substitute the correct letter).

When Setup asks you to select an installation type, select Guided.
Choose the destination folder and your startup preferences.

When Setup asks you to select remote access components, select
the Allow this System to Connect to MAGic Enabled Servers check
box.

Note:

Setup will only install support for Citrix if the client software
is installed on the computer. Be sure to install the Citrix
client software before installing MAGic.

Follow the instructions and complete the installation. If you have a
single-user license of MAGic, you can activate your product after
the installation.
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Authorizing MAGic for Remote Access

When using MAGic in terminal sessions, you must have a license that
includes the remote access option (purchased separately). After you
establish a remote connection, the version of MAGic installed on the
server attempts to obtain remote access authorization from the client
computer. In order to obtain authorization from the client, the version of
MAGic installed on the client computer must have either a stand-alone
(local) license, access to a license server with one or more free tokens,
or an attached dongle. The client computer’s license must include the
remote access option to provide authorization for the version of MAGic
installed on the server.

If the server cannot find the correct authorization, it searches for a
license server. The license server must have one or more free tokens,
and its multi-user license must include the remote access option. The
server cannot obtain authorization from its own stand-alone (local)
license or a dongle during terminal sessions.

If the server cannot find any authorization, an error message appears
and you will not be able to use MAGic during the terminal session.

Tip: For information on activating a single-user license or setting
up a license server for a multi-user license, refer to Product
Activation on page 4.

Starting a Terminal Session

After you have installed MAGic on the server and client computers and
activated your license, you can begin using MAGic in terminal sessions.
To start a terminal session, do the following:

1.  Start the client software you are using to connect to the server
(such as Program Neighborhood or Remote Desktop).

Tip: Remote Desktop is included with Windows XP and is also
available for Windows 2000. To start this program, open the
Start menu and choose Programs, Accessories,
Communications, Remote Desktop Connection.
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2. Establish a connection to the server. For information on
connections, refer to your client software documentation.

3. Log on to the server using the credentials supplied by the system
administrator.

4. Inthe terminal session window, start MAGic on the server. You will
not hear any speech feedback until you start MAGic on the server.

Tip: You can start MAGic quickly by pressing WINDOWS Key+R
and typing “MAGic” followed by the version number. For
example, to start MAGic 10.0, you would type “MAGic10” and
press ENTER.

Ending a Terminal Session

When you have finished working in a terminal session, you can choose
to either disconnect or log off from the server. If you disconnect, you
end the connection between the client and server computers, but your
user account remains logged on. Depending on how the administrator
sets up the server, this may cause your programs and files to remain
open and use system resources. Logging off from the server ends the
connection and closes all your programs and files, ensuring that they do
not consume unnecessary server resources.
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Appendix B
SAPI Synthesizers on a Network

When you use MAGic on a network, the procedure for selecting a
synthesizer other than Eloquence is the same as when you use a
standalone version of MAGic.

When you update your synthesizer list in the Voices dialog box, the
synthesizers that populate the Available SAPI Synthesizers list are
stored in your user profile. Therefore, the next time that you log into
MAGic this information will automatically be displayed for you.

If you move to another computer that does not have the same
synthesizers installed, and attempt to change your synthesizer to one of
these, you will receive a message stating, “The synthesizer you have
selected is not available. Would you like this synthesizer removed from
your list of available synthesizers.” Choose Yes if you do not want to use
this synthesizer on the network in the future. Choose No to have the
synthesizer remain in your list for use on other network computers.
When you choose an unavailable synthesizer, after attempting to find
the synthesizer on your computer, MAGic will continue to use the
synthesizer you were using before attempting to change synthesizers. If
you select a synthesizer other than Eloquence as your synthesizer and
move to a computer that does not have that synthesizer installed, when
you log into MAGic, you will receive notification of this. Speech then
defaults to Eloquence.
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Appendix C

Hot Keys

General

Start MAGic ALT+CTRL+M

Minimize/Restore the MAGic User MAGic Key+U

Interface

Pass Through Key MAGic Key+3

Refresh Screen MAGic Key+ESC

Open MAGic Context Menu MAGic Key+APPLICATION Key

Magnification, Views, & Enhancements
MAGic Key+NUM PAD PLUS or

Increase Magnification CTRL+EQUALS

MAGic Key+NUM PAD MINUS or
Decrease Magnification CTRL+DASH
Magnification Toggle On/Off MAGic Key+DELETE

Toggle between 1x Magnification MAGic Key+SHIFT+DELETE

Switch to Next Magnified View MAGic Key+NUM PAD SLASH

Switch to Previous Magnified View SHIFT+MAGic Key+NUM PAD SLASH

Toggle Color Enhancements On/Off | MAGic Key+F12

Toggle Cursor Enhancements On/Off | MAGic Key+F8

Toggle Mouse Enhancements On/Off | MAGic Key+F4
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Panning and Screen Movement

Pan Right MAGic Key+RIGHT ARROW
Pan Left MAGic Key+LEFT ARROW
Pan Down MAGic Key+DOWN ARROW
Pan Up MAGic Key+UP ARROW

Increase Speed during Panning

NUM PAD PLUS

Decrease Speed during Panning

NUM PAD MINUS

Move to Left Edge of Screen in
Magnified View

MAGic Key+HOME

Move to Right Edge of Screen in
Magnified View

MAGic Key+END

Move to top of Screen

MAGic Key+PAGE UP

Move to Bottom of Screen

MAGic Key+PAGE DOWN

Move to Beginning of Next Line

MAGic Key+ENTER

Tracking

Tracking Toggle On/Off

MAGic Key+R

Move View to Mouse Pointer

MAGic Key+NUM PAD 5

Move View to Cursor

SHIFT+MAGic Key+NUM PAD 5

Tether Mouse to Display

CTRL+INSERT+NUM PAD MINUS

Cursor Movement

Route Cursor to Mouse

INSERT+NUM PAD PLUS

Route Mouse to Cursor

INSERT+NUM PAD MINUS
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Locator Mode

Start Locator

MAGic Key+F10

Stop Locator and Move to Selected
Area

ENTER

Stop Locator without Moving the ESC

Magnified Area

Move Left LEFT ARROW

Move Right RIGHT ARROW

Move Up UP ARROW

Move Down DOWN ARROW

Move to End of Line END

Move to Beginning of Line HOME

Move to Top of Screen PAGE UP

Move to Bottom of Screen PAGE DOWN
Quick View Frame

Toggle Quick View Frame On/Off MAGic Key+Q

Set upper left corner of frame

MAGic Key+LEFT BRACKET

Set lower right corner of frame

MAGic Key+RIGHT BRACKET

Create frame around current dialog
box option

MAGic Key+LEFT BRACKET twice

quickly

Open Quick View Manager

MAGic Key+9
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Speech

Silence Current Speech

CTRL

Enable/Disable Speech

MAGic Key+F3

Language Toggle MAGic Key+F11
Set Current Screen Echo INSERT+S
Select Verbosity Scheme ALT+INSERT+S

Document and Text Reading

Read All from Location

MAGic Key+SPACEBAR or
INSERT+DOWN ARROW

Read Active Window (reads from the
beginning of document window)

MAGic Key+SPACEBAR (twice) or
INSERT+DOWN ARROW (twice)

Say Currently Selected Text

MAGic Key+CTRL or
INSERT+SHIFT+DOWN ARROW

Say Current Character

NUM PAD 5

MAGic Key+ALT or INSERT+NUM PAD

Say Current Word 5

MAGic Key+ALT (twice) or
Spell Current Word INSERT+NUM PAD 5 (twice)
Say Next Word INSERT+RIGHT ARROW
Say Prior Word INSERT+LEFT ARROW

Select Next Word

INSERT+SHIFT+RIGHT ARROW

Select Prior Word

INSERT+SHIFT+LEFT ARROW

Say Current Line

MAGic Key+L or INSERT+UP ARROW

Say Next Line

DOWN ARROW
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Say Prior Line

UP ARROW

Read to Cursor INSERT+HOME
Read from Cursor INSERT+PAGE UP
Say Current Sentence MAGic Key+S

Say Next Sentence

CTRL+MAGic Key+S

Say Current Paragraph MAGic Key+P
Read Column from Current Position | MAGic Key+C
Say Contents of Clipboard MAGic Key+X

Note:

When using the document and text reading commands, if you move
the mouse MAGic reads from the current location of the mouse

pointer. If you move the insertion point, MAGic reads from the

location of the insertion point.

Dialog Box Reading

Say Title Bar

MAGic Key+T or INSERT+T

Read Bottom of Window

INSERT+PAGE DOWN

Say Top Line of Window

INSERT+END

Say Default Button in Dialog Box

INSERT+E

Say Window Prompt and Text

MAGic Key+TAB or INSERT+TAB

Say Current Access Key

SHIFT+NUM PAD 5

Table Reading

Say Current Cell ALT+CTRL+NUM PAD 5
Say Cell to Right ALT+CTRL+RIGHT ARROW
Say Cell to Left ALT+CTRL+LEFT ARROW
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Say Cell Below ALT+CTRL+DOWN ARROW
Say Cell Above ALT+CTRL+UP ARROW
Say First Cell ALT+CTRL+HOME
Say Last Cell ALT+CTRL+END
Say First Cell in Column ALT+CTRL+SHIFT+UP ARROW
Say Last Cell in Column ALT+CTRL+SHIFT+DOWN ARROW
Say First Cell in Row ALT+CTRL+SHIFT+LEFT ARROW
Say Last Cell in Row ALT+CTRL+SHIFT+RIGHT ARROW
Typing Echo
Cycle through Indicate Capitalization
options MAGic Key+F2
Cycle through Typing Echo Unit
options INSERT+2
Mouse Echo
Mouse Echo Toggle MAGic Key+M

Note: Toggling the mouse echo rotates between speak lines, speak words,
and mouse echo off.

Some actions in MAGic do not have hot keys assigned. You can define hot
keys for these features from within the Keyboard Assignments dialog box.
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Appendix D
Windows Shortcut Keys

General

Get Help

F1

Open the Start menu

WINDOWS Key or CTRL+ESC

Open Windows Explorer

WINDOWS Key+E

Open the Run dialog box

WINDOWS Key+R

Find file or folder from Desktop

F3

Minimize all windows

WINDOWS Key+M

Switch between programs ALT+TAB

Quit the active program ALT+F4

For Windows and Menus

Open the application control menu ALT+SPACEBAR
Move to the menu bar ALT

Choose a menu command ENTER

Move between menus

ALT, arrow keys

Close a menu ESC

Close a cascading menu ALT

Open a child window control menu ALT+HYPHEN
Close a child window CTRL+F4

Open the context menu

APPLICATION Key or SHIFT+F10
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For Dialog Boxes

Move through dialog box options TAB

Move backward through dialog box

options SHIFT+TAB

Move to another tab CTRL+TAB
Reverse direction through tabs CTRL+SHIFT+TAB
Move to first option HOME

Move to last option END

Select or clear an item in a list

SPACEBAR or CTRL+SPACEBAR

Select or clear a check box

SPACEBAR

For Reading Text

Move left one character LEFT ARROW

Move right one character RIGHT ARROW

Move left one word CTRL+LEFT ARROW
Move right one word CTRL+RIGHT ARROW
Move to beginning of line HOME

Move to end of line END

Move up one paragraph CTRL+UP ARROW
Move down one paragraph CTRL+DOWN ARROW
Scroll up one screen PAGE UP

Scroll down one screen PAGE DOWN

Move to beginning of document CTRL+HOME

Move to end of document CTRL+END
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For Editing Text

Copy CTRL+C

Cut CTRL+X

Paste CTRL+V

Undo CTRL+Z

Delete character to the left BACKSPACE

Delete character to the right DELETE

Select one character left SHIFT+LEFT ARROW
Select one character right SHIFT+RIGHT ARROW
Select one word left CTRL+SHIFT+LEFT ARROW
Select one word right CTRL+SHIFT+RIGHT ARROW
Select to beginning of line SHIFT+HOME

Select to end of line SHIFT+END

Select to beginning of document CTRL+SHIFT+HOME
Select to end of document CTRL+SHIFT+END
Select all CTRL+A

For Windows Explorer

Rename selected file or folder F2

Open properties ALT+ENTER

Refresh a window F5

Switch between panes F6 or TAB

Go up a level BACKSPACE

139



A
action....ccceeeiiii 98
Adobe Acrobat/Reader............... 117
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010 52,57
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C
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closing MAGIC.....ccccccevveerennee. 16, 38

saving settings........ccccevvennee. 16
color enhancements .............. 42,59
blending ..., 61

brightness .................o.o. 60, 61

button ....ccoovveiiii 18, 42
color switching......cccceeveeeneeeen. 62
contrast.....coooviiiiiiiiiiie, 61
inverting colors..........ccccuuueeee 60
level .., 61
Quick View Frame.................... 69
restoring system colors .......... 60
schemes.....cooeiieeiieniiieereen. 59
tint e, 61
colors
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borders................. 63, 64, 65, 66
(oLl | 0] S 56
cursor enhancements.............. 57
iNVerting......ccoceceeeeeiens 60
level .., 61
monochrome.......cccooevvueriennnnn. 61
mouse enhancements............. 52
mouse pointer.........cccceeeeeeeeene. 51
Quick View Frame.............. 68, 69
switching......cccceeeeeiiiiiicennnn, 62
contacting Freedom Scientific... 120
context...cviiicii 83
context menu ........cceeeeeneennenen 33, 38
context sensitive help............ 20, 29
contrast ....oovevveiieiiiii, 61
(o (0131 1 1= 1 51,52
cursor enhancements ..... 41, 55, 57
attributes ... 56
button ....ceovviiieee, 18, 41
(o0] (0] 5 56, 57
display.....cccceiiiiiiii, 57
SAMPLE e 57
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styles. ..o, 57
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highlighting.......ccceeeeeeeeie 94
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documentation feedback ........... 121
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(=] 105
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F
factory settings......ccccceeeee. 38, 55
File menuU.....ooeeeviveieiieceees 19, 37
frames ..o 67, 69
Freedom Scientific......cccveeuennen. 19
contact information............... 120
technical support .................. 121
Web Site .covueiveeieiieieeeeen, 120
FULL CrOSS cevvieeeieee e 70
FULL VIEW e 48
G
global voice adjustment .............. 77
H
height ..o, 53,58
help .o, 20, 29
highlight ..., 94

alignment.............cooce 75
(o] (0] £ J 94
styles...oumeii 94
hot keys20, 39, 40, 42, 44, 45, 46,
97, 98, 131
Adobe Acrobat/Reader.......... 117
document reading................. 135
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general.....ccocveeeeeeeennnnicenn, 131
Internet Explorer................... 116
Locator ....ccovvevieeiieeiieeeeeeee, 133
magnification, views, &
enhancements.......ccccccuuunnnenn. 131
mouse echo..........ccceeeeernens 136
Outlook .......ccooevvrii, 118
PANNING ...uuiiiiiaaas 132
speecCh......oooriiiiiceee 134
table reading.....ccccceeeeeeennnnn. 135
text reading ......ooeueeieinnnnnnnn. 134
tracking .....coevveeiiiiiiiiiiieninene, 132
typing echo ....cooevneeeeeer 136
Windows.....ccooveveciceeeeeieeeee 137
Word......ooooeeeiiceeeee e 100
I
incremental panning .................. 73
individual voice adjustment ........ 82
installing MAGIC ...........coeeeeeeeeen. 3
authorization.........cc.ccccccooo 4
automatic or guided.................. 4
NEtWOrK ....oovveeeieiieceeeeeeee, 4
Internet Explorer....................... 116
inverting
black and white....................... 60
brightness............ 51, 52,57, 60
colors ............ 51,52, 57, 60, 94
cursor enhancements.............. 57
highlight.......cccoooies 94



Locator ... 70
mouse enhancements............. 52
mouse pointer.........ccccceeeeeeenes 51

K
keyboard.........cccceevviiiiriiinnnns 21, 31
assignments.........cccceeennns 32,97
CuUsStomizing....ccoevveeeveeereeeeennnnn. 32
MAGIC KeY .....coverereeecceeeeeeene, 96
MENU ..ceuunneeeernnnnn. 19, 31, 32, 96

L
language......ccocneins 80
languages .......eeeemeeeeeins 27
length ... 53, 58
lens VieW....ccoveiveiiennnenn. 48, 64, 65
line...oo e, 57
line delay.....ccccevvviiiiiiiis 73
line lock ..oovveeeiieeeeeee e 76
line Wrap...ccoeeveeeee e, 72
(0 Yof=) (0] 18, 44, 69
border......ccoovviiiiiiii, 70
button.......ccoo 44
hot keys....ccoovirririiii, 133
style .o, 70

M
M button ... 39
MAGic Context Menu ................... 34
MAGic Key......ccceeeveunnnnn.n. 20, 31, 96
passing through ..................... 31
maghnification........cccccevvennnnnnnnie 39
buttons.....coeoveeviiiiiieeens 17, 39
(o [ 1] o] - 2 48
enabling and disabling............ 39
features....cccoeeeverriieiiiii, 47
hot keys....ccoovviriiiiiiiin, 131

increasing and decreasing 40, 49
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smoothing..................ec 50
tracking ... 73
vertical stretch.......cccoceuuneennen 49
view properties .......ccccceeeereenns 62
Magnification button.............. 17, 39
magnified area ............... 50, 56, 59
magnified views .................... 18, 40
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menu tracking .................o. 74,75
minimizing MAGic on startup ...... 26
MONOChIOME......ceveiieceeeeeeee e, 61
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mouse echo............... 21, 45, 46, 84
button ..o, 18
hot Keys ....ouvvevvvveeivieiieneieeee 136
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mouse enhancements ................. 50
attributes ... 51
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